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1
Installing the Operating System

Ä
CAUTION: Do not add optional hardware or third-party devices to your computer until the operating 
system is successfully installed. Doing so may cause errors and may prevent the operating system from 
installing properly.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL 
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the 
software that runs the computer or prevent its proper installation.

The first time the computer is turned on, the operating system is automatically installed. This 
takes approximately 10 minutes, depending on the system hardware configuration. At the 
beginning of the installation process, you are prompted to select the appropriate language for the 
operating system. Read and follow the instructions that appear on the screen to complete the 
installation. During this process, do not turn off your computer unless you are directed to do so.

✎ If the computer shipped with more than one operating system language on the hard drive, the 
installation process could take up to 60 minutes.

1.1 Installing or Upgrading Device Drivers 
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices.

If prompted for the I386 directory, replace the path specification with C:\i386, or use the Browse 
button in the dialog box to locate the i386 folder. This action points the operating system to the 
appropriate drivers.

Obtain the latest support software, including support software for the operating system from 
www.hp.com. Click Driver Downloads, select Download drivers and software, enter the 
model number of the computer, and press Enter.

You can also obtain the latest support software on CDs. The following Web site provides 
information on how to purchase a support software CD subscription:

http://h18000.www1.hp.com/support/files/desktops/us/purchase.html 

✎ If the computer has an optical CD-RW drive, install the appropriate application to be able to 
write to the drive. To install the application, double-click the Setup Software icon on the desktop 
or the application launcher and select the Easy CD Creator and Direct CD option when 
prompted.
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Installing the Operating System
1.2 Transferring Files and Settings
Use the Microsoft Windows XP Files and Settings Transfer Wizard to move files and settings 
from an old computer to a new one. Click Start > All Programs > Accessories > System Tools 
> Files and Settings Transfer Wizard.

1.3 Backing Up and Restoring Files

1.3.1 Creating a Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to create a backup file or tape.

✎ A backup file can be saved to a hard disk, a floppy disk, CD, USB flash media device, tape drive, 
or to any other removable or nonremovable media.

1.3.2 Restoring from the Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to restore files from a backup file.

✎ A backup file can be on a hard disk, a floppy disk, CD, USB flash media device, tape drive, or 
any other removable or nonremovable media.

1.4 Converting to NTFS
Windows XP Professional

To convert a FAT or FAT32 volume to NTFS,

1. Click Start > All Programs > Accessories > Command Prompt.

2. Type convert drive_letter: /fs:ntfs (where drive_letter is the volume to be converted) and 
press Enter.

1.5 HP Software
The Microsoft Windows XP Professional operating system is preinstalled on the computer and 
will be configured automatically the first time the computer is turned on. The following HP 
software may also be installed at that time on selected models: 

■ Computer Setup Utilities

■ HP Support Software including device drivers

■ Online Safety & Comfort Guide

■ Power Management with energy saver features

■ Security Management tools

■ Software Support Management tools
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Installing the Operating System
Certain drivers and utilities are available only in selected languages. You can obtain the latest 
version of these files, in English and selected other languages, in one of three ways:

■ Support Software CD 

■ HP Web site at www.hp.com 

■ Restore Plus! CD, which is supplied with many HP models

✎ Additional HP software may be required in certain situations. 
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2
Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer 
system when contacting Customer Support. These tools can also be used to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the computer are recognized by the system and 
functioning properly.

■ Determine information about the operating environment of the computer.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts.

✎ All features identified in this chapter may not be available on all HP products.

2.1 Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST 
checks the following items to ensure that the computer system is functioning properly:

■ Keyboard

■ Memory modules

■ All mass storage devices 

■ Processors

■ Controllers

✎ If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
will need to enter the password before continuing. Refer to Section 3.1, “Initial Configuration 
and Deployment” for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error 
messages and their solutions refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup Utilities
Use Computer Setup Utilities (F10) to: 

■ Change factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration, including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, 
or USB flash media devices.

■ Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests 
run during a Full Boot. You can set the system to:

❏ always Quick Boot (default);

❏ periodically Full Boot (from every 1 to 30 days); or

❏ always Full Boot.

■ Select Post Messages Enabled or Disabled to change the display status of Power-On 
Self-Test (POST) messages. Post Messages Disabled suppresses most POST messages, such 
as memory count, product name, and other non-error text messages. If a POST error occurs, 
the error is displayed regardless of the mode selected. To manually switch to Post Messages 
Enabled during POST, press any key (except F1 through F12).

■ Establish an Ownership Tag, the text of which is displayed each time the system is turned on 
or restarted.

■ Enter the Asset Tag or property identification number assigned by the company to this 
computer.

■ Enable the power-on password prompt during system restarts (warm boots) as well as during 
power-on.

■ Establish a setup password that controls access to Computer Setup (F10) Utility and the 
settings described in this section.

■ Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable removable media boot ability.

■ Enable or disable legacy diskette write ability (when supported by hardware).

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Replicate the system setup by saving system configuration information on diskette and 
restoring it on one or more computers.

■ Execute self-tests on a specified ATA hard drive (when supported by drive).

■ Enable or disable DriveLock security (when supported by drive).
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2.2.1 Using Computer Setup (F10) Utilities 
Computer Setup can be accessed only by turning on the computer or restarting the system. To 
access the Computer Setup Utilities menu, complete the following steps: 

1. Turn on or restart the computer. If you are in Windows, click Start >Shut Down >Restart. 

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary. 

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select your language from the list and press the Enter key.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, 
Security, Power, and Advanced. 

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and 
down) keys to select the option you want, then press Enter. To return to the Computer Setup 
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit. 

❏ If you have made changes that you do not want applied, select Ignore Changes and 
Exit.

❏ To reset to factory settings or previously saved default settings, select Set Defaults and 
Exit. This option will restore the original factory system defaults.

Ä
CAUTION: Do NOT turn the computer power OFF while the ROM is saving your F10 Computer Setup 
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer after 
you exit the F10 Setup screen. 
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2.2.2 Computer Setup Menu

Heading Option Description

File System Information Lists:
• Product name
• SKU number (some models)
• Processor type/speed/stepping
• Cache size (L1/L2) (dual core processors have this listed twice)
• Total installed memory size, speed, and operating mode (Single 

Channel, Dual Channel, or Asymmetric) (if applicable)
• Installed memory in each DIMM slot, grouped by channels (if 

applicable)
• Integrated MAC address for embedded, enabled NIC (if 

applicable)
• System BIOS (includes family name and version)
• Chassis serial number
• Asset tracking number

About Displays copyright information.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to select a drive containing a new BIOS.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a formatted 
1.44-MB diskette, a USB flash media device, or a diskette-like 
device (a storage device set to emulate a diskette drive).
Restore from Removable Media
Restores system configuration from a diskette, a USB flash media 
device, or a diskette-like device.

Default Setup Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.

Apply Defaults 
and Exit

Applies the currently selected default settings and clears any 
established passwords.

Ignore Changes 
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and 
Exit

Saves changes to system configuration or default settings and exits 
Computer Setup.

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage Device 
Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are 
displayed. The following options may be presented.

Diskette Type
Identifies the highest capacity media type accepted by the diskette 
drive.
Legacy Diskette Drives
Options are 3.5" 1.44 MB, and 5.25" 1.2 MB.

Drive Emulation
Allows you to select a drive emulation type for a certain storage 
device. (For example, a Zip drive can be made bootable by 
selecting diskette emulation.) 

Drive Type Emulation Options

ATAPI Zip drive None (treated as Other)

Diskette (treated as diskette drive)

ATA Hard disk None (treated as Other) 

Hard disk (treated as hard drive)

Legacy diskette No emulation options available

CD-ROM drive No emulation options available

ATAPI LS-120 None (treated as Other).

Diskette (treated as diskette drive).

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Device 
Configuration 
(continued)

Default Values IDE/SATA
If selected, this option allows you to specify the default values for the 
Multisector Transfers, Transfer Mode, and Translation Mode for ATA 
devices.

Multisector Transfers (ATA disks only)
Specifies how many sectors are transferred per multi-sector 
PIO operation. Options (subject to device capabilities) are 
Disabled, 8, and 16.
Transfer Mode (IDE devices only)
Specifies the active data transfer mode. Options (subject to 
device capabilities) are PIO 0, Max PIO, Enhanced DMA, 
Ultra DMA 0, and Max UDMA.
Translation Mode (ATA disks only)
Lets you select the translation mode to be used for the device. 
This enables the BIOS to access disks partitioned and 
formatted on other systems and may be necessary for users of 
older versions of UNIX (e.g., SCO UNIX version 3.2). 
Options are Automatic, Bit-Shift, LBA Assisted, User, and 
None

Ä CAUTION: Ordinarily, the translation mode selected 
automatically by the BIOS should not be changed. If the 
selected translation mode is not compatible with the 
translation mode that was active when the disk was 
partitioned and formatted, the data on the disk will be 
inaccessible.

Translation Parameters (ATA disks only)

✎ This feature appears only when User translation mode is 
selected.

Allows you to specify the parameters (logical cylinders, 
heads, and sectors per track) used by the BIOS to translate 
disk I/O requests (from the operating system or an 
application) into terms the hard drive can accept. Logical 
cylinders may not exceed 1024. The number of heads may 
not exceed 256. The number of sectors per track may not 
exceed 63. These fields are only visible and changeable 
when the drive translation mode is set to User.

Storage Options Removable Media Boot 
Enables/disables ability to boot the system from removable media.

Legacy Diskette Write
Enables/disables ability to write data to legacy diskettes.

✎ After saving changes to Removable Media Write, the computer 
will restart. Turn the computer off, then on, manually.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Storage Options 
(continued)

BIOS DMA Data Transfers
Allows you to control how BIOS device I/O requests are serviced. 
When “Enable” is selected, the BIOS will service ATA device read 
and write requests with DMA data transfers. When “Disable” is 
selected, the BIOS will service ATA device read and write requests 
with PIO data transfers.

SATA Emulation
Allows you to choose how the SATA controller and devices are 
accessed by the operating system. 
“Separate IDE Controller” is the default option. Up to 4 SATA and 2 
PATA devices may be accessed in this mode. The SATA and PATA 
controllers appear as two separate IDE controllers. Use this option 
with Microsoft Windows 2000 and Windows XP.

• SATA 0 is seen as SATA Primary Device 0
• SATA 1 (if present) is seen as SATA Secondary Device 0
• SATA 2 (if present) is seen as SATA Primary Device 1.
• SATA 3 (if present) is seen as SATA Secondary Device 1.

“Combined IDE Controller” is the other option. Up to 2 PATA and 2 
SATA devices may be accessed in this mode. The SATA and PATA 
controllers appear as one combined IDE controller. Use this option 
with Microsoft Windows 98 and earlier operating systems.

• PATA Primary Device 0 replaces SATA 1
• PATA Primary Device 1 replaces SATA 3

IDE Controller
Allows you to enable or disable the primary IDE controller. This 
feature is supported on some models only.

Primary SATA Controller
Allows you to enable or disable the Primary SATA controller.

Secondary SATA Controller
Allows you to enable or disable the Secondary SATA controller. This 
feature is supported on some models only.

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of 
performing the Drive Protection System (DPS) self-tests.

✎ This selection will only appear when at least one drive capable of 
performing the DPS self-tests is attached to the system.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Boot Order Allows you to:
• Specify the order in which attached devices (such as a USB 

flash media device, diskette drive, hard drive, optical drive, or 
network interface card) are checked for a bootable operating 
system image. Each device on the list may be individually 
excluded from or included for consideration as a bootable 
operating system source.

• Specify the order of attached hard drives. The first hard drive in 
the order will have priority in the boot sequence and will be 
recognized as drive C (if any devices are attached).

✎ MS-DOS drive lettering assignments may not apply after a 
non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device 
specified in Boot Order, restart the computer and press F9 when the 
monitor light turns green. After POST is completed, a list of bootable 
devices is displayed. Use the arrow keys to select the preferred 
bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Security Smart Card 
Options

Allows you to enable/disable the Smart Card to be used in place of 
the Power-On Password. This option only appears if a Smart Card 
reader is attached to the system.

Setup Password Allows you to set and enables setup (administrator) password. 

✎ If the setup password is set, it is required to change Computer 
Setup options, flash the ROM, and make changes to certain plug 
and play settings under Windows.

Power-On 
Password

Allows you to set and enable power-on password.

Password Options 
(This selection will 
appear only if a 
power-on 
password is set.)

Allows you to:
• Lock legacy resources (appears if a setup password is set)
• Enable/disable network server mode (appears if a power-on 

password is set)
• Specify whether the password is required for warm boot 

(CTRL+ALT+DEL). (appears if a power-on password is set)

Smart Cover Allows you to:
• Lock/unlock the Cover Lock.
• Set the Cover Removal Sensor to Disable/Notify User/Setup 

Password.

✎ Notify User alerts the user that the sensor has detected that the 
cover has been removed. Setup Password requires that the setup 
password be entered to boot the computer if the sensor detects 
that the cover has been removed.

This feature is supported on some models only. 

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Security 
(continued)

Embedded 
Security

Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.
• Enable/disable power-on authentication support.
• Reset authentication credentials.

This feature is supported on some models only. 

Device Security Enables/disables serial ports, parallel port, front USB ports, system 
audio, internal speaker (does not affect external speakers) network 
controllers (some models), MultiBay devices (some models), SMBus 
controller (some models), SCSI controllers (some models), and 
embedded security device.

Network Service 
Boot

Enables/disables the computer’s ability to boot from an operating 
system installed on a network server. (Feature available on NIC 
models only; the network controller must reside on the PCI bus or be 
embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST).
• Chassis serial number or Universal Unique Identifier (UUID) 

number. The UUID can only be updated if the current chassis 
serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)

• Keyboard locale setting (for example, English or German) for 
System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for drives 
that support ATA Security. When this feature is enabled, the user is 
prompted to provide one of the DriveLock passwords during POST. 
If neither is successfully entered, the hard drive will remain 
inaccessible until one of the passwords is successfully provided 
during a subsequent cold-boot sequence.

✎ This selection will only appear when at least one drive that 
supports ATA Security is attached to the system.

OS Security • Data Execution Prevention (some models) (enable/disable). 
Helps prevent OS security breaches.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize this feature.

• Intel Virtualization Technology (some models) (enable/disable). 
Changing this setting requires turning the computer off and then 
back on.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize this feature.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Security
(continued)

Data Execution 
Prevention

Enable/Disable.  
Data Execution Prevention Mode help prevent OS security breaches.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize the function. 

Power OS Power 
Management

• Runtime Power Management - Enable/Disable. Allows certain 
operating systems to reduce processor voltage and frequency 
when the current software load does not require the full 
capabilities of the processor. This option is only available when 
supported by the processor. 

• Idle Power Savings - Extended/Normal. Allows certain 
operating systems to decrease the processors power 
consumption when the processor is idle. This option is only 
available when supported by the processor.

• ACPI S3 Support - Enables or disables ACPI S3 support.
• ACPI S3 Hard Disk Reset - Enabling this causes the BIOS to 

ensure hard disks are ready to accept commands after 
resuming from S3 before returning control to the operating 
system.

• ACPI S3 PS2 Mouse Wakeup - Enables or disables waking from 
S3 due to PS2 mouse activity.

• USB Wake on Device Insertion - Allows system to wake from 
Standby on USB device insertion.

Hardware Power 
Management

SATA power management enables or disables SATA bus and/or 
device power management.

Thermal Fan idle mode - This bar graph controls the minimum permitted fan 
speed.

✎ This setting only changes the minimum fan speed. The fans are 
still automatically controlled.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced*
*For 
advanced 
users only

Power-On Options Allows you to set:
• POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
• POST messages (enable/disable).
• F9 prompt (enable/disable). Enabling this feature will display 

the text F9=Boot Menu during POST. Disabling this feature 
prevents the text from being displayed but pressing F9 will still 
access the Shortcut Boot (Order) Menu screen. See Storage > 
Boot Order for more information. 

• F10 prompt (enable/disable). Enabling this feature will display 
the text F10=Setup during POST. Disabling this feature 
prevents the text from being displayed but pressing F10 will still 
access the Setup screen.

• F12 prompt (enable/disable). Enabling this feature will display 
the text F12=Network Service Boot during POST. 
Disabling this feature prevents the text from being displayed but 
pressing F12 will still force the system to attempt booting from 
the network.

• Option ROM* prompt (enable/disable). Enabling this feature 
will cause the system to display a message before loading 
options ROMs. (This feature is supported on some models only.)

• Remote wakeup boot source (remote server/local hard drive).
• After Power Loss (off/on/previous state): Set this option to ON:

•Off - causes the computer to remain powered off when power 
is restored.

•On - causes the computer to power on automatically as soon 
as power is restored.

•On - allows you to power on the computer using a power strip 
switch, if the computer is connected to an electric power strip.

•Previous state - causes the computer to power on automatically 
as soon as power is restored, if it was on when power was 
lost.

✎ If you turn off power to your computer using the switch on a 
power strip, you will not be able to use the suspend/sleep feature 
or the Remote Management features.

• POST Delay (in seconds) (enable/disable). Enabling this feature 
will add a user-specified delay to the POST process. This delay 
is sometimes needed for hard disks on some PCI cards that spin 
up very slowly; so slowly that they are not ready to boot by the 
time POST is finished. The POST delay also gives you more time 
to press F10 to enter Computer (F10) Setup.

• I/O APIC Mode (enable/disable). Enabling this feature will 
allow Microsoft Windows Operating Systems to run optimally. 
This feature must be disabled for certain non-Microsoft 
Operating Systems to work properly.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced* 
(continued)
*For 
advanced 
users only

Power-On Options 
(continued)

Allows you to set: (continued)
• Hyper-threading (enable/disable)
• Set Up Browse Mode (enable/disable). Enabling this feature 

permits Computer Setup to be viewed, but not changed, without 
entering the setup password.

• Limit CPUID Maximum Value to 3 - Restricts the number of 
CPUID functions reported by the microprocessor. Enable this 
feature if booting to WinNT.

• ACPI/USB Buffers @ Top of Memory (enable/disable). 
Enabling this feature places USB memory buffers at the top 
of memory. The advantage is that some amount of memory 
below 1 MB is freed up for use by option ROMs. The 
disadvantage is that a popular memory manager, HIMEM.SYS, 
does not work properly when USB buffers are at top of memory 
AND the system has 64 MB or less of RAM.

Execute Memory 
Test

Restarts the computer and executes the POST memory test.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you 
specify.

Onboard Devices Allows you to set resources for or disable onboard system devices 
(diskette controller, serial port, or parallel port).

PCI Devices • Lists currently installed PCI devices and their IRQ settings. 
• Allows you to reconfigure IRQ settings for these devices or to 

disable them entirely. These settings have no effect under an 
APIC-based operating system.

PCI VGA 
Configuration

Displayed only if there are multiple PCI video adapters in the 
system. Allows you to specify which VGA controller will be the 
“boot” or primary VGA controller.

Bus Options On some models, allows you to enable or disable:
• PCI SERR# Generation.
• PCI VGA palette snooping, which sets the VGA palette 

snooping bit in PCI configuration space; only needed when 
more than one graphics controller is installed.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced* 
(continued)
*For 
advanced 
users only

Device options Allows you to set: 
• Printer mode (bi-directional, EPP & ECP, output only).
• Num Lock state at power-on (off/on).
• S5 Wake on LAN (enable/disable).

• To disable Wake on LAN during the off state (S5), use the arrow 
(left and right) keys to select the Advanced > Device Options 
menu and set the S5 Wake on Lan feature to “Disable.” This 
obtains the lowest power consumption available on the computer 
during S5. It does not affect the ability of the computer to Wake on 
LAN from suspend or hibernation, but will prevent it from waking 
from S5 via the network. It does not affect operation of the network 
connection while the computer is on.

• If a network connection is not required, completely disable the 
network controller (NIC) by using the arrow (left and right) keys to 
select the Security > Device Security menu. Set the Network 
Controller option to “Device Hidden.” This prevents the network 
controller from being used by the operating system and reduces the 
power used by the computer in S5.

• Processor cache (enable/disable).
• Unique Sleep State Blink Patterns. Allows you to choose an LED 

blink pattern that uniquely identifies each sleep state.
•1 blink followed by 2-sec. pause = S1
•2 blinks followed by 2-sec. pause = S2
•3 blinks followed by 2-sec. pause = S3

• Integrated Video (enable/disable) Allows you to use integrated 
video and PCI Up Solution video at the same time (available on 
some models only).

✎ Inserting a PCI or PCI Express video card automatically disables 
Integrated Video. When PCI Express video is on, Integrated 
Video must remain disabled.

• Monitor Tracking (enable/disable). Allows ROM to save 
monitor asset information.

• NIC PXE Option ROM Download (enable/disable). The BIOS 
contains an embedded NIC option ROM to allow the unit to 
boot through the network to a PXE server. This is typically used 
to download a corporate image to a hard drive. The NIC 
option ROM takes up memory space below 1MB commonly 
referred to as DOS Compatibility Hole (DCH) space. This space 
is limited. This F10 option will allow users to disable the 
downloading of this embedded NIC option ROM thus giving 
more DCH space for additional PCI cards which may need 
option ROM space. The default will be to have the NIC option 
ROM enabled.

PCI VGA 
Configuration

Displayed only if there are multiple PCI video adapters in the 
system. Allows you to specify which VGA controller will be the 
“boot” or primary VGA controller.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.2.3 Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command 
with the Computer Setup (F10) Utility before Restore is needed.

✎ It is recommended that you save any modified computer configuration settings to a diskette, a 
USB flash media device, or a diskette-like device (a storage device set to emulate a diskette 
drive) and save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media 
emulating a diskette with the saved configuration and perform the Restore from Removable 
Media command with the Computer Setup (F10) Utility.

2.3 HP Insight Diagnostics

✎ HP Insight Diagnostics is included on the Documentation and Diagnostics CD with some 
computer models only.

The HP Insight Diagnostics utility allows you to view information about the hardware 
configuration of the computer and perform hardware diagnostic tests on the subsystems of the 
computer. The utility simplifies the process of effectively identifying, diagnosing, and isolating 
hardware issues.

The Survey tab is displayed when you invoke HP Insight Diagnostics. This tab shows the current 
configuration of the computer. From the Survey tab, there is access to several categories of 
information about the computer. Other tabs provide additional information, including diagnostic 
test options and test results. The information in each screen of the utility can be saved as an html 
file and stored on a diskette or USB HP Drive Key.

Use HP Insight Diagnostics to determine if all the devices installed on the computer are 
recognized by the system and functioning properly. Running tests is optional but recommended 
after installing or connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports 
available before placing a call to the Customer Support Center.

✎ Third party devices may not be detected by HP Insight Diagnostics.

2.3.1 Accessing HP Insight Diagnostics
You must boot to the Documentation and Diagnostics CD, as described in the steps below, to 
access HP Insight Diagnostics.

1. While the computer is on, insert the Documentation and Diagnostics CD into an optical drive 
on the computer.

2. Shut down the operating system and turn off the computer.

3. Turn on the computer. The system will boot to the CD.
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✎ If the system does not boot to the CD in the optical drive, you may need to change the boot order 
in the Computer Setup (F10) utility so that the system attempts to boot to the optical drive before 
booting to the hard drive. Refer to the Computer Setup (F10) Utility Guide on the Documentation 
and Diagnostics CD for more information.

4. When prompted, press the Y key if you want to operate in Safe mode or any other key if you 
want to operate in Regular mode.

✎ Regular mode is the default mode if no keys are pressed within the specified time frame. If the 
screen remains blank after pressing any key other than Y, try rebooting and select safe mode 
when prompted.

5. Select the appropriate language and click Continue.

✎ It is recommended that you accept the assigned default keyboard for your language unless you 
want to test your specific keyboard.

6. In the End User License Agreement page, click Agree if you agree with the terms. The HP 
Insight Diagnostics utility launches with the Survey tab displayed.

2.3.2 Survey Tab
The Survey tab displays important system configuration information. In the View section on the 
left side of the screen, you can select the Summary view to see limited configuration data or 
select the Advanced view to see all the data in the selected category. Regardless of whether you 
choose Advanced or Summary, the following categories of information are available on the 
Survey tab:

All—Gives a listing of all categories of information about the computer.

Overview—Gives you a listing of general information about the computer.

Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows asset tag, system serial number, and processor information.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port 
settings, plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices 
connected to the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on 
the system board and any memory modules installed.

Miscellaneous—Shows information obtained from the computer configuration memory 
(CMOS), system management BIOS data, system board data, and diagnostics component 
information.

Storage—Shows information about storage media connected to the computer. This list includes 
all fixed disks, diskette drives, and optical drives.

System—Shows information about the system board, processor, chassis, and BIOS, plus internal 
speaker and PCI bus information.
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2.3.3 Test Tab
The Test tab allows you to choose various parts of the system to test. You can also choose the 
type of test and testing mode.

There are two test modes to choose from:

■ Interactive Mode—Provides maximum control over the testing process. The diagnostic 
software will prompt you for input during tests that require your interaction.You may also 
determine whether the test passed or failed.

■ Unattended Mode—Does not display prompts and requires no interaction. If errors are 
found, they are displayed when testing is complete.

There are three types of tests to choose from:

■ Quick Test—Provides a predetermined script where a sample of each hardware component 
is exercised and requires no user intervention in either Unattended or Interactive mode.

■ Complete Test—Provides a predetermined script where each hardware component is fully 
tested. There are more tests available in the Interactive mode, but these require user 
intervention.

■ Custom Test—Provides the most flexibility in controlling the testing of a system. The 
Custom Test mode allows you to specifically select which devices, tests, and test parameters 
are run.

To begin testing:

1. Select the Test tab.

2. On the left side of the tab, select the Type of Test to perform (Quick, Complete, or 
Custom).

3. On the left side of the tab, select the Test Mode (Interactive or Unattended).

4. Select the device to be tested from the drop-down list.

5. Choose how you want the test to be executed, either Number of Loops or Total Test Time. 
When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you desire to have the diagnostic test for a specified time period, enter the amount 
of time in minutes.

6. Click Begin Testing to start the test. The Status tab, which allows you to monitor the 
progress of the test, is automatically displayed during the testing process. When the test is 
complete, the Status tab shows whether the device passed or failed.

7. If errors are found, go to the Log tab and click the Error Log to display more detailed 
information and recommended actions.
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2.3.4 Status Tab
The Status tab displays the status of the selected tests. The type of test executed (Quick, 
Complete, or Custom) is also displayed. The main progress bar displays the percent complete of 
the current set of tests. While testing is in progress, a Cancel Testing button is displayed for use 
if you want to cancel the test.

After testing has completed, the Cancel Testing button is replaced with a Retest button. The 
Retest button will retest the last set of tests executed. This enables you to re-run the set of tests 
without having to re-enter the data in the Test tab.

The Status tab also shows:

■ The devices being tested

■ The tests that are running

■ The overall elapsed time

■ The individual elapsed test times

■ The condition status of each test

2.3.5 Log Tab
The Log tab contains two logs, a Test Log and an Error Log, each of which can be selected from 
the left side of the tab.

The Test Log displays all tests that have been executed, the number of times of execution, the 
number of times the test failed, and the time it took to complete the test. The Clear Test Log 
button will clear the contents of the Test Log.

The Error Log displays the tests for devices that have failed during the diagnostic testing and 
includes the following columns of information. 

■ The Description section describes the error that the diagnostic test found. 

■ The Recommended Repair will give a recommended action that should be performed to 
resolve the failed hardware. 

■ The Failed Count is the number of times the test has failed.

■ The Error Code provides a numerical code for the failure. The error codes are defined in the 
Help tab.

■ The Clear Error Log button will clear the contents of the Error Log.

2.3.6 Saving and Printing Information in HP Insight Diagnostics
You can save the information displayed in the HP Insight Diagnostics Status and Log tabs to a 
diskette or a USB 2.0 HP Drive Key (64MB or higher). You can not save to the hard drive. The 
system will automatically create an html file that has the same appearance as the information 
displayed on the screen.

1. Insert a diskette or USB 2.0 HP Drive Key (capacity must be 64MB or higher). USB 1.0 
Drive Keys are not supported.

2. Click Save in the upper right corner of the tab.

3. Select Save to the floppy or Save to USB key.

4. Enter a file name in the File Name box and click the Save button. An html file will be saved 
to the inserted diskette or USB HP Drive Key.
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5. Print the information from the storage device used to save it.

✎ To exit HP Insight Diagnostics, click Exit in the upper right corner of the screen then remove the 
Documentation and Diagnostics CD from the optical drive.

2.3.7 Downloading the Latest Version of HP Insight Diagnostics
1. Go to www.hp.com.

2. Click the Driver Downloads or Support & Troubleshooting link.

3. Click the Download driver and software radio button.

4. Enter your product number (for example, dc7600) in the text box and press the Enter key.

5. Select your product.

6. Select your OS.

7. Click the Diagnostics link.

8. Select HP Insight Diagnostics and click Download.

✎ The download includes instructions on how to create the bootable CD.
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3
Desktop Management

HP Client Management Solutions provides standards-based solutions for managing and 
controlling desktops, workstations, and notebook PCs in a networked environment. 

The key capabilities and features of desktop management are:

■ Initial configuration and deployment

■ Remote system installation

■ Software updating and management

■ ROM flash

■ Asset tracking and security

■ Fault notification and recovery

✎ Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment
HP computers come with a preinstalled system software image. After a brief software 
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by: 

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as Altiris Deployment Solution, to replace the 
preinstalled software with a customized software image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and 
processes. The PC Deployment section of the HP Lifecycle Solutions Web site 
(http://whp-sp-orig.extweb.hp.com/country/us/en/solutions.html) provides information to help 
you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with 
recovery of system software, configuration management and troubleshooting, and power 
management.
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3.1.1 Altiris Deployment Solution Agent
This program is pre-loaded on the computer. When installed, it enables communication with the 
administrator Deployment Solution console.

To install Altiris Deployment Solution Agent:

1. Click Start.

2. Click All Programs.

3. Click Software Setup.

4. Click Next.

5. Scroll down and click on the link to install Altiris AClient.

3.1.2 HP Local Recovery
Local Recovery backs-up data and system files to a protected area on the hard drive. If data or 
files are lost, deleted, or corrupted, Local Recovery can be used to retrieve data or restore the last 
good system image.

To install this pre-loaded program:

1. Click Start.

2. Click Local Recovery.

3. Click Next.

4. Scroll down and click on the link to install HP Local Recovery.

3.2 Remote System Installation
Remote System Installation allows you to start and set up your system using the software and 
configuration information located on a network server by initiating the Preboot Execution 
Environment (PXE). The Remote System Installation feature is usually used as a system setup 
and configuration tool, and can be used for the following tasks:

■ Formatting a hard drive.

■ Deploying a software image on one or more new PCs.

■ Remotely updating the system BIOS in flash ROM. See Section 3.4.1, “Remote ROM 
Flash.”

■ Configuring the system BIOS settings.

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot 
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the 
screen to continue the process. The default boot order is a BIOS configuration setting that can be 
changed to always attempt to PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC 
deployment and management easier and less time-consuming, ultimately lowering the total cost 
of ownership and making HP PCs the most manageable client PCs in the enterprise environment. 
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3.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops, workstations, and 
notebooks:

■ HP System Software Manager

■ HP Client Manager

■ HP Client Management Solutions using Altiris

■ HP Local Recovery

■ Dantz Backup and Recovery

■ HP Proactive Change Notification

■ HP Subscriber's Choice

3.3.1 HP System Software Manager
HP System Software Manager (SSM) is a free utility that automates remote deployment of 
device drivers and BIOS updates for networked HP business PCs. When SSM runs, it silently 
(without user interaction) determines the revision levels of drivers and BIOS installed on each 
networked client system and compares this inventory against system software SoftPaqs that have 
been tested and stored in a central file store. SSM then automatically updates any down-revision 
system software on the networked PCs to the later levels available in the file store. Since SSM 
only allows distribution of SoftPaq updates to the correct client system models, administrators 
can confidently and efficiently use SSM to keep system software updated.

System Software Manager integrates with enterprise software distribution tools such as 
Microsoft Systems Management Server (SMS). Using SSM, you can distribute customer-created 
or third-party updates that have been packaged in the SSM-format.

SSM may be downloaded at no charge by visiting www.hp.com/go/ssm.

3.3.2 HP Client Manager
HP Client Manager, developed with Altiris, is available free for supported HP business desktop, 
notebook, and workstation models. SSM is integrated into HP Client Manager and enables 
central tracking, monitoring, and management of the hardware aspects of HP client systems.

Use HP Client Manager to:

■ Get valuable hardware information such as CPU, memory, video, and security settings

■ Monitor system health to fix problems before they occur

■ Install drivers and BIOS updates without visiting each PC

■ Remotely configure BIOS and security settings

■ Automate processes to quickly resolve hardware problems

HP Client Manager uses the same Altiris infrastructure as the other Altiris client lifecycle 
management solutions. This design provides a significant benefit for the IT staff, since only one 
infrastructure needs to be setup and maintained. Since information is stored in one database, you 
get complete and consistent inventory reports as well as system health and security information. 
You use a single, consistent console interface for scheduling and tracking progress of both 
hardware and software management tasks for client systems.

For more information on HP Client Manager, visit www.hp.com/go/easydeploy.
Service Reference Guide, dx7200 390812-001 3–3

http://www.hp.com/go/ssm
http://www.hp.com/go/easydeploy


Desktop Management
3.3.3 HP Client Management Solutions using Altiris
Additional Altiris client management solutions can be purchased through HP that complement 
the hardware management capabilities of HP Client Manager. These Altiris solutions address 
client IT lifecycle challenges including:

■ Inventory assessment

■ Software license compliance

■ Personality migration

■ Software image deployment

■ Software distribution

■ Asset management

■ Client backup and recovery

■ Problem resolution

For more information on HP Client Management Solutions using Altiris, visit 
www.hp.com/go/easydeploy.

HP and Altiris have a unique alliance that extends beyond sales and marketing to include joint 
development and technology sharing that spans HP Client, Server, OpenView, and Services 
groups to provide best-of-breed solutions for HP partners and customers.

Starting in 1999, Compaq personal systems group and Altiris entered into an alliance to combine 
the strength of Compaq as a pioneer in PC hardware and manageability with the strength of 
Altiris' PC deployment and migration capabilities. The relationship expanded into a strategic 
alliance with the introduction of comprehensive cost-reducing IT lifecycle management solutions 
including the jointly developed HP Client Manager, which provides best-of-breed hardware 
management for HP PCs.

Building upon the success of the personal systems group, in 2001 the industry standard servers 
group introduced the ProLiant Essentials Rapid Deployment Pack, an OEM version of Altiris 
Deployment Solution combined with HP's SmartStart Toolkit. HP utilizes this solution for 
provisioning ProLiant servers (including blade servers) as well as Blade PCs, a core component 
of HP's Consolidated Client Infrastructure.

Following the HP and Compaq merger, the alliance has continued to expand with the following 
offerings:

■ Altiris Deployment Solution is available for a free 30-day trial for HP business PCs, after 
which a license may be purchased.

■ HP Local Recovery, a client backup/recovery utility, is available for free with HP business 
PCs.

■ Altiris Connector for HP OpenView provides client inventory and event integration with HP 
OpenView Network Node Manager, Operations, and Service Desk.

■ Altiris Connector for HP Systems Insight Manager enables consolidated deployment and 
management of HP clients and servers from the HP Systems Insight Manager console.

HP leads the market by offering a single management solution and console for deploying and 
configuring PCs, handhelds, thin clients, and Windows and Linux servers plus rich integration 
with HP enterprise management tools. HP offers extensive training and services expertise 
available from the HP Services organization and Altiris. This combination of HP Client 
Management Solutions and services capability provides the best choice for customers trying to 
reduce the cost and complexity of managing client systems.
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3.3.4 HP Local Recovery
Local Recovery provides data and system file protection for HP business desktops, notebooks, 
and workstations. With Local Recovery, you can quickly recover and get back to work when 
information is accidentally deleted or your operating system is corrupted. Designed for 
disconnected or seldom-connected users, Local Recovery protects your HP computer's data and 
system state through scheduled snapshots stored in a protected area on the local hard disk. You 
can initiate a backup or restore by simply clicking your mouse or pressing the F11 key in a 
pre-boot environment. System backup and disaster recovery is now easy for all users regardless 
of connectivity.

Local Recovery is available for free with HP business PCs. Two additional client recovery 
products are also available. Upgrading to these products provides you with additional recovery 
features:

■ Local Recovery Pro—Provides all the capabilities of Local Recovery plus support for 
backup and recovery to a secondary hard drive and for open and locked files. During a 
backup snapshot, open/locked file support preserves information in open applications such as 
E-mail messages, presentations, and word processing documents.

■ Recovery Solution—Provides complete enterprise-level backup and recovery of PCs from a 
central administrative console. The solution supports data backup to a protected area on the 
local hard disk drive as well as to a network storage area. This network-based recovery 
feature provides a high level of protection against data lost due to hard drive failure or stolen 
and misplaced PCs.

For more information on HP Local Recovery, visit www.hp.com/go/easydeploy.

3.3.5 Dantz Retrospect Express
Dantz Retrospect Express protects a single Windows desktop or notebook computer. Retrospect 
Express allows recovery from data loss due to viruses, newly installed software, user error, 
damaged hardware, hardware upgrades, hackers, and lost or stolen computers. It offers a choice 
between simple duplicates or comprehensive backups and an intuitive setup wizard to get you up 
and running in minutes. Retrospect Express comes with Disaster Recovery built into the product 
for the best protection available. Visit http://www.dantz.com/en/partners/oem_solutions.dtml to 
view a list of hardware manufacturers who bundle Retrospect with their products and to learn 
where to buy these products.

Install Retrospect Express and perform your first backup in less than two minutes. With 
Retrospect, you can implement a backup plan by answering a few simple questions. Restores are 
quick and painless. When you need to perform a restore, Retrospect Express automatically 
locates files even if you do not know which piece of backup media contains the files.

Duplicate Files and Folders to an External Hard Drive with the Push of a Button. The duplicate 
operation copies information from the computer's hard drive to the external hard drive. (For 
external hard drives with a built-in backup button, duplicates can be initiated simply by pressing 
the button.) With duplicates, the files and folders on the external hard drive can be easily viewed, 
manipulated, and restored by using Windows Explorer. The duplication process saves space by 
overwriting any previous backup data on the external drive and saves time by copying only files 
that are new or that have changed since the last backup.

Back Up Multiple Versions of Files and Folders. Comprehensive backups retain prior versions of 
files and folders and allow you to roll back a computer to any prior point in time before a 
data-corrupting event occurred. Each time a backup operation is performed, Retrospect Express 
creates a restore point, which can contain all the information a user needs to retrieve files or 
restore an entire computer (disaster recovery)—including all operating system files and settings, 
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device drivers, and applications and their settings. Restore points are captured quickly and they 
provide 100% accurate restores to any point in time that a backup was performed—exceeding the 
capability of other backup software.

For more information on Dantz Retrospect Express, visit http://www.dantz.com.

3.3.6 Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site in order to 
proactively and automatically:

■ Send you Proactive Change Notification (PCN) E-mails informing you of hardware and 
software changes to most commercial computers and servers, up to 60 days in advance

■ Send you E-mail containing Customer Bulletins, Customer Advisories, Customer Notes, 
Security Bulletins, and Driver alerts for most commercial computers and servers

You create your own profile to ensure that you only receive the information relevant to a specific 
IT environment. To learn more about the Proactive Change Notification program and create a 
custom profile, visit http://www.hp.com/go/pcn.

3.3.7 Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply 
you with personalized product tips, feature articles, and/or driver and support 
alerts/notifications. Subscriber’s Choice Driver and Support Alerts/Notifications will deliver 
E-mails notifying you that the information you subscribed to in your profile is available for 
review and retrieval. To learn more about Subscriber’s Choice and create a custom profile, visit 
http://www.hp.com/go/pcn.

3.3.8 Retired Solutions
The Desktop Management Task Force (DMTF) introduced the Desktop Management Interface 
(DMI) standard almost ten years ago. Due to new standards adoption such as the Common 
Information Model (CIM), the DMTF has initiated end-of-life for DMI. Given other 
advancements in HP Client Management Solutions, HP Systems Insight Manager, and 
Microsoft's implementation of CIM, known as Windows Management Instrumentation (WMI), 
the HP Insight Management Agent is no longer being provided on new HP commercial desktop, 
workstation, and notebook models introduced after January 1, 2004.

The Insight Management (IM) Agent provided the following features:

■ DMI support allowed a client system to be managed by Insight Manager 7 or other 
DMI-compliant management applications.

■ A Web agent allowed the system to be managed both locally and remotely by a web browser.

■ Health alerting could notify the user locally or be sent to a central console.

Insight Manager has been replaced by HP Systems Insight Manager Software (HP SIM). HP SIM 
uses WMI to retrieve client system information. The Altiris Connector for HP Systems Insight 
Manager is available and enables the HP Client Management Solutions through the HP SIM 
console.

HP Client Management Solutions support reporting of health alerts to a system management 
console or optionally to be displayed locally on the client computer. Microsoft WMI is standard 
with Windows 2000 and Windows XP. WMI provides hardware inventory and alert information 
directly through the Windows OS to a system management application.
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3.4 ROM Flash
The computer's BIOS is stored in a programmable flash ROM (read only memory). By 
establishing a setup password in the Computer Setup (F10) Utility, you can protect the ROM 
from being unintentionally updated or overwritten. This is important to ensure the operating 
integrity of the computer. Should you need or want to upgrade the BIOS, you may download the 
latest BIOS images from the HP driver and support page: http://www.hp.com/support/files.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set 
the setup password on one or more PCs simultaneously. For more information, visit 
http://www.hp.com/go/ssm.

3.4.1 Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
computers directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely on multiple computers results in a consistent 
deployment of, and greater control over, HP PC BIOS images over the network. It also results in 
greater productivity and lower total cost of ownership.

✎ The computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager or System 
Software Manager at http://h18000.www1.hp.com/im/prodinfo.html.

3.4.2 HPQFlash
The HPQFlash utility is used to locally update or restore the system BIOS on individual PCs 
through a Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the product 
name/number of the computer when prompted.

3.4.3 Boot Block Emergency Recovery Mode
Boot Block Emergency Recovery Mode permits system recovery in the unlikely event of a ROM 
flash failure. For example, if a power failure were to occur during a BIOS upgrade, the ROM 
flash would be incomplete. This would render the system BIOS unusable. The Boot Block is a 
flash-protected section of the ROM that contains code that checks for a valid system BIOS image 
when the system is turned on.

■ If the system BIOS image is valid, the system starts normally.

■ If the system BIOS image is not valid, a failsafe Boot Block BIOS provides enough 
support to:

❏ search removable media for BIOS image files. If an appropriate BIOS image file is 
found, it is automatically flashed into the ROM.

❏ start the system from bootable removable media that automatically invokes system BIOS 
upgrade utilities.
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When an invalid system BIOS image is detected, the system power LED will blink red 8 times, 
one blink every second. Simultaneously, the speaker will beep 8 times. If the portion of the 
system ROM containing the video option ROM image is not corrupt, “Boot Block Emergency 
Recovery Mode” will be displayed on the screen.

To recover the system after it enters Boot Block Emergency Recovery Mode, complete the 
following steps:

1. Turn off the power.

2. Insert a diskette, CD, or USB flash device containing the desired BIOS image file in the root 
directory. Note: The media must be formatted using the FAT12, FAT16, or FAT32 file 
system.

3. Turn on the computer.

If no appropriate BIOS image file is found, the failsafe Boot Block BIOS will attempt to start 
the system from a bootable device. If no bootable device is found, you will be prompted to 
insert media containing a BIOS image file or BIOS upgrade utility.

If the system successfully reprograms the ROM, the system will automatically power off.

4. Remove the removable media used to upgrade the BIOS.

5. Turn the power on to restart the computer.

3.4.4 Replicating the Setup
In a managed networked environment HP Client Manager or System Software Manager (SSM) 
may be used to replicate a setup configuration to many systems. For more information on HP 
Client Manger and SSM, visit http://www.hp.com/go/easydeploy.

✎ Both procedures require a diskette drive or a supported USB flash media device, such as an HP 
Drive Key.

Copying to Single Computer

Ä
CAUTION: A setup configuration is model-specific. Unpredictable results may occur if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7nnn 
Ultra-Slim Desktop to a dx6nnn Slim Tower.

1. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

2. If you are using a USB flash media device, insert it now.

3. Turn on the computer.

4. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

5. If you are using a a diskette, insert it now.
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6. Select File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.

7. Turn off the computer to be configured and insert the configuration diskette or USB flash 
media device.

8. Turn on the computer to be configured.

9. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

10. Select File > Replicated Setup > Restore from Removable Media, and follow the 
instructions on the screen.

11. Restart the computer when the configuration is complete.

Copying to Multiple Computers

Ä
CAUTION: A setup configuration is model-specific. Unpredictable results may occur if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7nnn 
Ultra-Slim Desktop to a dx6nnn Slim Tower.

This method takes a little longer to prepare the configuration diskette or USB flash media device, 
but copying the configuration to target computers is significantly faster.

✎ A bootable diskette is required for this procedure or to create a bootable USB flash media device. 
If Windows XP is not available to use to create a bootable diskette, use the method for copying to 
a single computer instead (see “Copying to Single Computer”).

1. Create a bootable diskette or USB flash media device. See “Supported USB Flash Media 
Device” or “Unsupported USB Flash Media Device.”

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

2. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

3. If you are using a USB flash media device, insert it now.

4. Turn on the computer.

5. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

6. If you are using a diskette, insert it now.

7. Select File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.
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8. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration 
diskette or USB flash media device. To obtain this utility, go to 
http://www.hp.com/support/files and enter the model number of the computer.

9. On the configuration diskette or USB flash media device, create an autoexec.bat file 
containing the following command:

repset.exe
10. Turn off the computer to be configured. Insert the configuration diskette or USB flash media 

device and turn the computer on. The configuration utility will run automatically.

11. Restart the computer when the configuration is complete.

Creating a Bootable Device

Supported USB Flash Media Device

Supported devices have a preinstalled image to simplify the process of making them bootable. 
All HP or Compaq and most other USB flash media devices have this preinstalled image. If the 
USB flash media device being used does not have this image, use the procedure later in this 
section (see “Unsupported USB Flash Media Device”).

To create a bootable USB flash media device, you must have:

■ A supported USB flash media device.

■ A bootable DOS diskette with the FDISK and SYS programs. (If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.)

■ A PC that is bootable from a USB flash media device.

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

1. Turn off the computer.

2. Insert the USB flash media device into one of the computer’s USB ports and remove all other 
USB storage devices except USB diskette drives.

3. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

4. Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click Yes 
(Y) to enable large disk support.

5. Enter Choice [5] to display the drives in the system. The USB flash media device will be the 
drive that closely matches the size of one of the drives listed. It will usually be the last drive 
in the list. Note the letter of the drive.

USB flash media device drive: __________

Ä
CAUTION:   If a drive does not match the USB flash media device, do not proceed. Data loss can occur. 
Check all USB ports for additional storage devices. If any are found, remove them, reboot the computer, 
and proceed from step 4. If none are found, either the system does not support the USB flash media 
device or the USB flash media device is defective. DO NOT proceed in attempting to make the USB flash 
media device bootable.

6. Exit FDISK by pressing the Esc key to return to the A:\ prompt.
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7. If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

8. At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

Ä
CAUTION:   Be sure that you have entered the correct drive letter for the USB flash media device.

After the system files have been transferred, SYS will return to the A:\ prompt. Go to 
step 13.

9. Copy any files you want to keep from your USB flash media device to a temporary directory 
on another drive (for example, the system's internal hard drive).

10. At the A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

Ä
CAUTION:  Be sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more warnings and ask you each time whether you want to 
proceed. Enter Y each time. FORMAT will format the USB flash media device, add the 
system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Copy any files you saved in step 9 back to your USB flash media device.

13. Remove the diskette and reboot the computer. The computer will boot to the USB flash 
media device as drive C.

✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers.”

Unsupported USB Flash Media Device

To create a bootable USB flash media device, you must have:

■ A supported USB flash media device.

■ A bootable DOS diskette with the FDISK and SYS programs. (If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.)

■ A PC that is bootable from a USB flash media device.

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

1. If there are any PCI cards in the system that have SCSI, ATA RAID, or SATA drives 
attached, turn off the computer and unplug the power cord.

Ä
CAUTION: The power cord MUST be unplugged.

2. Open the computer and remove the PCI cards.
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3. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives. Close the computer cover.

4. Plug in the power cord and turn on the computer.

5. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

6. Go to Advanced > PCI Devices to disable both the PATA and SATA controllers. When 
disabling the SATA controller, note the IRQ to which the controller is assigned. You will 
need to reassign the IRQ later. Exit setup, confirming the changes.

SATA IRQ: __________

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new 
partition and mark it active. Exit FDISK by pressing the Esc key.

9. If the system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to 
reboot to the DOS diskette.

10. At the A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash 
media device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI 
cards that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Advanced > PCI Devices and re-enable the PATA and SATA controllers that were 
disabled in step 6. Put the SATA controller on its original IRQ.

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility. Refer to the Computer Setup (F10) Utility Guide on the Documentation and 
Diagnostics CD for instructions. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers.”
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3.4.5 Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled, the power button can 
function either as an on/off switch or as a standby button. The stand-by feature does not 
completely turn off power, but instead causes the computer to enter a low-power standby state. 
This allows you to power down quickly without closing applications and to return quickly to the 
same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Power Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Stand by.

After configuring the power button to function as a standby button, press the power button to put 
the system in a very low power state (standby). Press the button again to quickly bring the system 
out of standby to full power status. To completely turn off all power to the system, press and hold 
the power button for four seconds.

Ä
CAUTION: Do not use the power button to turn off the computer unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.

3.4.6 World Wide Web Site
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows that is different from the version included with the computer, you must install 
corresponding device drivers and utilities to ensure that all features are supported and 
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support. The Web site contains 
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft 
Windows operating system on the HP computer.

3.4.7 Building Blocks and Partners
HP management solutions integrate with other systems management applications, and are based 
on industry standards, such as:

■ Web-Based Enterprise Management (WBEM)

■ Windows Management Interface (WMI)

■ Wake on LAN Technology

■ ACPI

■ SMBIOS

■ Pre-boot Execution (PXE) support
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3.5 Asset Tracking and Security
Asset tracking features incorporated into the computer provide key asset tracking data that can be 
managed using HP Systems Insight Manager, HP Client Manager or other system management 
applications. Seamless, automatic integration between asset tracking features and these products 
enables you to choose the management tool that is best suited to the environment and to leverage 
the investment in existing tools. 

HP also offers several solutions for controlling access to valuable components and information. 
HP Embedded Security for ProtectTools, if installed, prevents unauthorized access to data and 
checks system integrity and authenticates third-party users attempting system access. (For more 
information, refer to the HP ProtectTools Security Manager Guide at www.hp.com.) Security 
features such as HP Embedded Security for ProtectTools, the Smart Cover Sensor and the Smart 
Cover Lock, available on some models, help to prevent unauthorized access to the internal 
components of the personal computer. By disabling parallel, serial, or USB ports, or by disabling 
removable media boot capability, you can protect valuable data assets. Memory Change and 
Smart Cover Sensor alerts can be automatically forwarded to system management applications to 
deliver proactive notification of tampering with a computer’s internal components.

✎ HP Embedded Security for ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock are 
available as options on some systems.

Use the following utilities to manage security settings on the HP computer:

■ Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide on 
the Documentation and Diagnostics CD included with the computer for additional 
information and instructions on using the Computer Setup Utilities.

■ Remotely, using HP Client Manager or System Software Manager. This software enables the 
secure, consistent deployment and control of security settings from a simple command-line 
utility.

The following table and sections refer to managing security features of the computer locally 
through the Computer Setup (F10) Utilities.

Computer Setup Utilities (F10) Security Features  
Feature Description

Smart Card Options Allows you to enable/disable the Smart Card to be used in 
place of the Power-On Password.

Setup Password Allows you to set and enable setup (administrator) password.

✎ If the setup password is set, it is required to change 
Computer Setup options, flash the ROM, and make changes 
to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable power-on password.

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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Password Options
(This selection will appear only 
if a power-on password is set.)

Allows you to:
• Lock legacy resources (appears if a setup password is set).
• Enable/disable network server mode.
• Specify whether the password is required for warm boot 

(CTRL+ALT+DEL) (appears if a power-on password is 
set).

Smart Cover Allows you to:
• Enable/disable the Cover Lock.
• Enable/disable the Cover Removal Sensor.

✎ Notify User alerts the user that the sensor has detected that 
the cover has been removed. Setup Password requires that 
the setup password be entered to boot the computer if the 
sensor detects that the cover has been removed.

This feature is supported on some models only and will only 
appear if a Smart Card reader is attached to the system.

Embedded Security Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.
• Enable/disable power-on authentication support. (some 

models)
• Reset authentication credential. (some models)

Device Security Enables/disables serial ports, parallel port, front USB ports, 
system audio, internal speakers (some models) network 
controllers (some models), MultiBay devices (some models), 
SMBus controller (some models), SCSI controllers (some 
models), and Embedded security device (some models).

Network Service Boot Enables/disables the computer’s ability to boot from an 
operating system installed on a network server. (Feature 
available on NIC models only; the network controller must 
reside on the PCI bus or be embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST). 
 
Chassis serial number or Universal Unique Identifier 
(UUID) number. The UUID can only be updated if the 
current chassis serial number is invalid. (These ID numbers 
are normally set in the factory and are used to uniquely 
identify the system.)

• Keyboard locale setting (for example, English or German) 
for System ID entry.

Computer Setup Utilities (F10) Security Features  (Continued)

Feature Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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DriveLock (some models) Allows you to assign or modify a master or user password for 
certain ATA hard drives. When this feature is enabled, the user 
is prompted to provide one of the DriveLock passwords during 
POST. If neither is successfully entered, the hard drive will 
remain inaccessible until one of the passwords is successfully 
provided during a subsequent cold-boot sequence.

✎ This selection will only appear when at least one drive that 
supports ATA Security is attached to the system.

OS Security (some models) • Data Execution Prevention (some models) 
(enable/disable). Helps prevent OS security breaches.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize this feature.

• Intel Virtualization Technology (some models) 
(enable/disable). Changing this setting requires turning 
the computer off and then back on.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize this feature.

Data Execution Prevention 
(some models)

Enable/Disable.  
Data Execution Prevention Mode help prevent OS security 
breaches.

✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize the function.

Computer Setup Utilities (F10) Security Features  (Continued)

Feature Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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3.5.1 Password Security
The power-on password prevents unauthorized use of the computer by requiring entry of a 
password to access applications or data each time the computer is turned on or restarted. The 
setup password specifically prevents unauthorized access to Computer Setup, and can also be 
used as an override to the power-on password. That is, when prompted for the power-on 
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the power-on password, 
even if one has been established.

3.5.2 Establishing a Setup Password Using Computer Setup
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com. Establishing a setup password through Computer Setup 
prevents modification of the computer (use of the Computer Setup (F10) utility) until the 
password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

Mechanical Security Features  
Feature Purpose How It Is Established

Memory Change Alerts Detects when memory 
modules have been added, 
moved, or removed; notifies 
user and system administrator.

For information on enabling 
Memory Change Alerts, 
refer to the online Desktop 
Management Guide on the 
Documentation and 
Diagnostics CD.

Cable Lock Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal. Can also be used to 
secure the computer to a fixed 
object to prevent theft.

Install a cable lock to secure 
the computer to a fixed 
object.

Security Loop Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal.

Install a lock in the security 
loop to prevent unwanted 
configuration changes or 
component removal.
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3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, Select File > Save Changes and Exit.

3.5.3 Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the computer 
when power is turned on, unless the password is entered. When a power-on password is set, 
Computer Setup presents Password Options under the Security menu. Password options include 
Password Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the 
password must also be entered each time the computer is rebooted. 

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, select File > Save Changes and Exit.

Entering a Power-On Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. When the key icon appears on the monitor, type the current password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

If a setup password has been established on the computer, you will be prompted to enter it each 
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears on the monitor, type the setup password, then press Enter.
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✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Changing a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart 

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears, type the current password, a slash (/) or alternate delimiter 
character, the new password, another slash (/) or alternate delimiter character, and the new 
password again as shown: 
current password/new password/new password

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press Enter.

5. The new password takes effect the next time you turn on the computer.

✎ Refer to “National Keyboard Delimiter Characters” for information about the alternate delimiter 
characters. The power-on password and setup password may also be changed using the Security 
options in Computer Setup.

Deleting a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the key icon appears, type the current password followed by a slash (/) or alternate 
delimiter character as shown: 
current password/

4. Press Enter.
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✎ Refer to the National Keyboard Delimiter Character table below for information about the 
alternate delimiter characters. The power-on password and setup password may also be changed 
using the Security options in Computer Setup.

National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you 
use for changing or deleting your password depend on the keyboard that came with your 
computer.

Clearing Passwords 
If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide 
on the Documentation and Diagnostics CD for instructions on clearing passwords.

If the system is equiped with an embedded security device, refer to the HP ProtectTools Security 
Manager Guide at www.hp.com.

3.5.4 DriveLock
DriveLock is an industry-standard security feature that prevents unauthorized access to the data 
on ATA hard drives. DriveLock has been implemented as an extension to Computer Setup. It is 
only available when hard drives that support the ATA Security command set are detected.

DriveLock is intended for HP customers for whom data security is the paramount concern. For 
such customers, the cost of the hard drive and the loss of the data stored on it is inconsequential 
when compared with the damage that could result from unauthorized access to its contents. In 
order to balance this level of security with the practical need to accommodate a forgotten 
password, the HP implementation of DriveLock employs a two-password security scheme. One 
password is intended to be set and used by a system administrator while the other is typically set 
and used by the end-user. There is no “back-door” that can be used to unlock the drive if both 
passwords are lost. Therefore, DriveLock is most safely used when the data contained on the 
hard drive is replicated on a corporate information system or is regularly backed up. 

National Keyboard Delimiter Characters
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish .
French Canadian é Polish - U.K. English /
German - Portuguese - U.S. English /
* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For 
users who do not fit the previously defined customer profile, this may be an unacceptable risk. 
For users who do fit the customer profile, it may be a tolerable risk given the nature of the data 
stored on the hard drive.

Using DriveLock
The DriveLock option appears under the Security menu in Computer Setup. The user is 
presented with options to set the master password or to enable DriveLock. A user password must 
be provided in order to enable DriveLock. Since the initial configuration of DriveLock is 
typically performed by a system administrator, a master password should be set first. HP 
encourages system administrators to set a master password whether they plan to enable 
DriveLock or keep it disabled. This will give the administrator the ability to modify DriveLock 
settings if the drive is locked in the future. Once the master password is set, the system 
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a 
power-on password is set and it matches the device’s user password, POST will not prompt the 
user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock 
password. Either the master or the user password may be used. Users will have two attempts to 
enter a correct password. If neither attempt succeeds, POST will continue but the drive will 
remain inaccessible.

DriveLock Applications
The most practical use of the DriveLock security feature is in a corporate environment. The 
system administrator would be responsible for configuring the hard drive which would involve, 
among other things, setting the DriveLock master password. In the event that the user forgets the 
user password or the equipment is passed on to another employee, the master password can 
always be used to reset the user password and regain access to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also 
establish a corporate policy for setting and maintaining master passwords. This should be done to 
prevent a situation where an employee intentionally or unintentionally sets both DriveLock 
passwords before leaving the company. In such a scenario, the hard drive would be rendered 
unusable and require replacement. Likewise, by not setting a master password, system 
administrators may find themselves locked out of a hard drive and unable to perform routine 
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. 
Users in this category include personal users or users who do not maintain sensitive data on their 
hard drives as a common practice. For these users, the potential loss of a hard drive resulting 
from forgetting both passwords is much greater than the value of the data DriveLock has been 
designed to protect. Access to Computer Setup and DriveLock can be restricted through the 
Setup password. By specifying a Setup password and not giving it to end users, system 
administrators are able to restrict users from enabling DriveLock.
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3.5.5 Smart Cover Sensor
Cover Removal Sensor, available on some models, is a combination of hardware and software 
technology that can alert you when the computer cover or side panel has been removed. There are 
three levels of protection, as described in the following table. 

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Removal Sensor, and select the desired security 
level.

4. Before exiting, select File > Save Changes and Exit.

Smart Cover Lock
The Smart Cover Lock is a software-controllable cover lock featured on some HP computers. 
This lock prevents unauthorized access to the internal components. Computers ship with the 
Smart Cover Lock in the unlocked position.

Ä
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password 
prevents unauthorized access to the Computer Setup utility.

✎ The Smart Cover Lock is available as an option on some systems.

Smart Cover Sensor Protection Levels
Level Setting Description

Level 0 Disabled Smart Cover Sensor is disabled (default).

Level 1 Notify User When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed.

Level 2 Setup Password When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed. You must enter the setup 
password to continue.

✎ These settings can be changed using Computer Setup. For more information about Computer 
Setup, see the Computer Setup (F10) Utility Guide.
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Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Lock > Lock option.

4. Before exiting, select File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Security > Smart Cover > Cover Lock > Unlock.

4. Before exiting, select File > Save Changes and Exit.

Using the Smart Cover FailSafe Key
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will 
need a Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the 
following circumstances:

■ Power outage

■ Startup failure

■ PC component failure (such as processor or power supply)

■ Forgotten password

Ä
CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order 
this key before you need one (Tamper-resistant wrench PN 166527-001 or tamper-resistant bits PN 
166527-002).

For more information about using the Smart Cover FailSafe Key, consult the Hardware 
Reference Guide.
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3.5.6 Cable Lock Provision
The rear panel of the computer accommodates a cable lock so that the computer can be 
physically secured to a work area. For illustrated instructions, please see the Removal and 
Replacement chapter for the specific chassis.

3.5.7 TPM Embedded Security Chip and HP ProtectTools Security 
Manager

The TPM Embedded Security Chip uses a root key protected in silicon to enhance native 
Microsoft operating system file and folder encryption and lay the foundation for authentication 
of TPM-enabled PCs to the corporate network.

HP ProtectTools Security Manager can be configured to prevent unauthorized access using Smart 
Cards, TPM Embedded security chips, USB tokens and other security technologies. HP 
ProtectTools Security Manager is completely customizable, providing the flexibility to choose 
the level of security that best meets customers’ needs.

For more information on HP Business PC security solutions, visit 
http://h18004.www1.hp.com/products/security.

3.6 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a 
fault notice to the network management application. With HP Client Manager, you can also 
remotely schedule diagnostics to automatically run on all managed PCs and create a summary 
report of failed tests.

3.6.1 Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in 
some HP computers. DPS is designed to help diagnose problems that might result in unwarranted 
hard drive replacement. 

When HP computers are built, each installed hard drive is tested using DPS, and a permanent 
record of key information is written onto the drive. Each time DPS is run, test results are written 
to the hard drive. Your service provider can use this information to help diagnose conditions that 
caused you to run the DPS software. Refer to the Troubleshooting Guide for instructions on using 
DPS.

3.6.2 Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000 volts without incurring any system downtime or data loss.

3.6.3 Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
computer. This feature displays a warning message when the normal range is exceeded, which 
gives you time to take action before internal components are damaged or data is lost.
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4
Serial and Parallel ATA Drive Guidelines and 

Features

✎ Serial ATA = SATA 
Parallel ATA = PATA 
 
HP only supports the use of a MultiBay PATA (IDE) hard drive on this model of computer. 
3.5-inch PATA hard drives are not supported.

4.1 SATA 1.5 and 3.0 Hard Drives

SATA connectors on the system board are color coded to make identification easier.

✎ If there is an error on the application of the attach rules, a POST error message may be displayed.

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5V, 12 V

Jumpers for configuring drive N/A

Data transfer rate, 40 GB 1.5 Gb/s
3.0 Gb/s (some models)

Data transfer rate, 80 GB and greater 3.0 Gb/s

SATA Identification Color Port
Attachment 
Sequence

Primary channel, device 0 Dark blue SATA 0 1

Primary channel, device 1 Light Blue SATA 2 4

Secondary channel, device 0 White SATA 1 2

Secondary channel, device 1 Orange SATA 3 3
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4.2 SATA Hard Drive Cables

4.2.1 SATA Data Cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the 
SATA 1.5 Gb/s drives.

Current HP desktop products ship with SATA 1.5 Gb/s or 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and 
never bend it tighter than a 30 mm (1.18 in) radius. 

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As 
shown in the table, each cable has 3 grounds, and 4 transmit/receive pins.

4.2.2 SATA Power Cable

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair
**P5 and P6 differential signal pair

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V 12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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4.3 PATA Device Information
This information applies to optical drives in a computer having one or two SATA drive 
controllers and a single PATA drive controller. 

Only a MultiBay PATA hard drive is supported on these computers. No other PATA hard drives 
are supported on these models.

4.4 PATA Cables

4.4.1 PATA Data Cable

Parallel ATA MultiBay Hard Drive Characteristics

Number of pins/conductors in data cable 40/80

Number of pins in power cable 4

Maximum data cable length 18 in (45.7 cm)

Data interface voltage 5V

Drive voltages 5V

Jumpers for configuring drive Required

Data transfer rate 24 MB/s

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
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4.4.2 PATA Power Cable

4.5 PATA Drive Installation Guidelines
The computer system boards for these products have one Parallel ATA (PATA) channel with a 
single connector. The channel can have up to two devices attached to it. All drives are connected 
to the channel using an industry-standard 80-conductor cable.

✎ The industry-standard 1.44 MB diskette drive has its own separate channel and is not included as 
a part of the maximum two drives.

Each drive attached to a channel must have a drive designation. If a drive is attached to the 
Device 0 cable position and its cable-select jumper is present, the drive is designated as Device 0. 
Similarly, if a drive is attached to the Device 1 cable position and its cable-select jumper is 
present, the drive is designated as Device 1.

For optimal performance of a computer system, all drives need to be attached to the PATA 
channel(s) in a specified sequence. This sequence is determined by the device class of the drives 
and by specific attach sequence rules.

4.5.1 PATA Device Classes
In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four 
different classes based upon the bandwidth demands they place on an ATA channel. The most 
demanding devices are in Class 1 and the least demanding are in Class 4.

General Attach Guidelines
■ The lower the device class number, the faster the device and the more bandwidth required. 

■ Drives installed in the Device 0 position receive the greatest possible bandwidth.

Pin Usage

1 +12 V

2 Ground

3 Ground

4 +5 V

Class 1 
Hard 
Drives

Class 2 
High Speed 

Optical Drives

Class 3
Optical Storage 

Drives

Class 4
Magnetic 

Storage Drives

Supported 
only on USDT 
chassis with 
MultiBay

DVD 
DVD-CD R/W

R/W CD-ROM  
CD-ROM 

Zip 
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4.6 SATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) SATA drives for the HP 
Personal Computers have built-in drive failure prediction that warns the user or network 
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault 
prediction and failure indication parameters such as reallocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.

4.7 Drive Capacities
The combination of the file system and the operating system used in the computer determines the 
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that 
may be properly accessed by the operating system. A single hard drive may therefore be 
subdivided into a number of unique drive partitions in order to make use of all of its space. 

Because of the differences in the way that drive sizes are calculated, the size reported by the 
operating system may differ from that marked on the hard drive or listed in the computer 
specification. Drive size calculations by drive manufacturers are bytes to the base 10 while 
calculations by Microsoft are bytes to the base 2.

4.8 SATA BIOS

Drive/Partition Capacity Limits

Maximum Size

File 
System

Controller 
Type Operating System

 
Partition Drive 

FAT 32 ATA Windows 2000/ XP 32 GB 128 PB

NTFS ATA Windows NT/2000/XP 2 TB 128 PB

Windows 2000 and XP Windows 9x, NT, and Linux

Enhanced Mode (default BIOS Setting) 
—Separate IDE controller

Compatibility Mode (non-default BIOS Setting) 
—Combined IDE controller

•PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of 
PATA controller’s Primary Channel 
- Device 1 is accessible as Device 1of 
PATA controller’s Primary Channel

•SATA Controller in Native Mode 
- SATA 0 is accessible as Device 0 of 
SATA controller’s Primary Channel 
- SATA 1 is accessible as Device 0 of 
SATA controller’s Secondary Channel 
SATA 2 is accessible as Device 1of 
SATA controller’s Primary Channel 
- SATA 3 is accessible as Device 1 of 
SATA controller’s Secondary Channel

•PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of the 
combined controller’s Secondary 
Channel 
- Device 1 is accessible as Device 1of the 
combined controller’s Secondary 
Channel

•SATA Controller in Legacy Mode 
- SATA 0 is accessible as Device 0 of the 
combined controller’s Primary Channel 
- SATA 1 is inaccessible 
- SATA 2 is accessible as device 1 of the 
combined controller’s Primary Channel 
- SATA 3 is inaccessible
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4.8.1 Legacy Mode
The Legacy mode is used to access devices attached to an embedded ATA controller. Each 
channel of the controller requires two fixed I/O address ranges and an IRQ. 

■ Primary Channel 

❏ Command block: 1F0h - 1F7h

❏ Control block: 3F6h

❏ IRQ: 14

■ Secondary Channel 

❏ Command block: 170h - 177h

❏ Control block: 376h

❏ IRQ: 15

4.8.2 Native Mode
The native mode is used to access devices attached to SATA controllers and is the default mode 
for all integrated SATA controllers. It is not supported by many legacy operating systems. 
Addresses are assigned by PCI Plug-n-Play BIOS and the IRQ is shared with multiple 
controllers. Base Address Registers for the Command and Control Block are found in the PCI 
Configuration Space.

■ Offset 10h—Primary Command base address

■ Offset 14h—Primary Control base address

■ Offset 18h—Secondary Command base address

■ Offset 1Ch—Secondary Control base address
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4.9 Mixed Devices Boot and Drive Letter Ordering

SATA Emulation Hard Drive Order
HDD Boot and Drive 

Letter Ordering

Separate IDE Controller 
(default). Used with Windows 
2000 and XP.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
A3. SATA 1 
A4. SATA 3
B1. IDE Device 0
B2. IDE Device 1

Separate IDE Controller. Used 
with Windows 2000 and XP.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0
B2. SATA 2
B3. SATA 1
B4. SATA 3

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
B1. IDE Device 0
B2. IDE Device 1

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0 
B2. SATA 2
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5
Identifying the Chassis, Routine Care, and 

Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures 
and precautions described in this chapter is essential for proper service.

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

5.1 Chassis Designations

5.1.1 Microtower (MT)
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5.1.2 Slim Tower (ST)
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5.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.

5.2.1 Generating Static
The following table shows that:

■ Different activities generate different amounts of static electricity. 

■ Static electricity increases as humidity decreases. 

✎ 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

Relative Humidity

Event 55% 40% 10%

Walking across carpet 
Walking across vinyl floor 
Motions of bench worker 
Removing DIPs* from plastic tube

7,500 V 
3,000 V 

400 V 
400 V

15,000 V 
5,000 V 

800 V 
700 V

35,000 V 
12,000 V 
6,000 V 
2,000 V

Removing DIPs* from vinyl tray 
Removing DIPs* from Styrofoam 
Removing bubble pack from PCB 
Packing PCBs in foam-lined box

2,000 V 
3,500 V 
7,000 V 
5,000 V

4,000 V 
5,000 V 

20,000 V 
11,000 V

11,500 V 
14,500 V 
26,500 V 
21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.
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5.2.3 Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

■ Heel straps/Toe straps/Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

5.2.4 Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

Static Shielding Protection Levels

Method Voltage

Antistatic plastic 
Carbon-loaded plastic 
Metallized laminate

1,500 
7,500  
15,000
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■ Static awareness labels

■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes

5.3 Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

■ Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and 
cold. 

■ Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all 
vented sides of the computer and above the monitor to permit the required airflow.

■ Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place 
the keyboard, with the keyboard feet down, directly against the front of the desktop unit as 
this also restricts airflow.

■ Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other 
foreign matter can block the vents and limit the airflow. Be sure to unplug the computer 
before cleaning the air vents.

■ Never operate the computer with the cover or side panel removed.

■ Do not stack computers on top of each other or place computers so near each other that they 
are subject to each other’s re-circulated or preheated air.

■ If the computer is to be operated within a separate enclosure, intake and exhaust ventilation 
must be provided on the enclosure, and the same operating guidelines listed above will still 
apply.

■ Keep liquids away from the computer and keyboard.

■ Never cover the ventilation slots on the monitor with any type of material.

■ Install or enable power management functions of the operating system or other software, 
including sleep states.

5.4 Routine Care

5.4.1 General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.
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4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

5.4.2 Cleaning the Computer Case
Follow all safety precautions in Section 5.4.1 before cleaning the computer.

To clean the computer case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.

5.4.3 Cleaning the Keyboard
Follow all safety precautions in Section 5.4.1 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section 
5.4.2.

When cleaning debris from under the keys, review all rules in Section 5.4.1 before following 
these procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

■ Visible debris underneath or between the keys may be removed by vacuuming or shaking.

■ Canned, pressurized air may be used to clean debris from under the keys. Caution should be 
used as too much air pressure can dislodge lubricants applied under the wide keys.

■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

■ Cleaning under a key may be done with a swab moistened with isopropyl alcohol and 
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use 
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before 
reassembly.
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5.4.4 Cleaning the Monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body follow the procedures in Section 5.4.2.    

5.4.5 Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull 
out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in Section 5.4.2.

5.5 Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly 
and assembly of the computer.

5.5.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off 
when the computer is in “Standby,” “Suspend,” or “Off” modes. 
 
You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage.

5.5.2 Tools and Software Requirements
To service the computer, you need the following:

■ Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

■ Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

■ Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

■ Phillips #2 screwdriver

■ Diagnostics software

■ HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or  
HP tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)
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5.5.3 Screws
The screws used in the computer are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, it can damage the unit. HP strongly recommends that all screws removed during 
disassembly be kept with the part that was removed, then returned to their proper locations.

✎ Metric screws have a black finish. 
U.S. screws have a silver finish and are used on hard drives only.

✎ As each subassembly is removed from the computer, it should be placed away from the work 
area to prevent damage.

5.5.4 Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with 
care to avoid damage. Apply only the tension required to seat or unseat the cables during 
insertion or removal from the connector. Handle cables by the connector whenever possible. In 
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way 
that they cannot be caught or snagged by parts being removed or replaced.

Ä
CAUTION: When servicing this computer, ensure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the computer. 

5.5.5 Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are actually mounted in the CPU.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard 
drive while the computer is on or in standby mode.

■ Before handling a drive, ensure that you are discharged of static electricity. While handling a 
drive, avoid touching the connector. For more information about preventing electrostatic 
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields such as monitors or speakers.
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5.5.6 Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a 
minimum lifetime of about three years. 

See the appropriate removal and replacement chapter for the chassis you are working on in this 
guide for instructions on the replacement procedures. 

Å
WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the 
battery.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.
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6
Removal and Replacement Procedures— 

Microtower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation” for initial 
safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer (See Section 6.2, 
“External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette or compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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6.2 External Security Devices

6.2.1 Installing a Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 

Insert the cable lock in the location shown below.
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6.2.2 Installing a Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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6.3 Access Panel 
1. Prepare the computer for disassembly (Section 6.1).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Loosen the captive thumbscrew 1 that secures the access panel to the computer chassis. 

3. Slide the access panel 2 back about 1 inch (2.5 cm), then lift it off the unit.

✎ You may want to lay the computer on its side to install internal parts. Be sure the side with the 
access panel and pull grip is facing up.

To install the access panel, reverse the removal procedure.
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6.4 Front Bezel 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.3).

3. To remove the front bezel, press in on the two bottom tabs on the left side of the bezel 1 so 
that they release from the chassis. Then press in on the upper tab on the left side of the bezel 
so that it releases from the chassis. The bezel will rotate out slightly from left to right.

Ä
CAUTION: Do not over-rotate or try to pull the bezel off at this point, otherwise you may break the 
remaining hooks on the inside of the bezel.

4. Press down on the upper right corner of the bezel to release the hook that secures the top of 
the bezel to the chassis. Continue to rotate the bezel, then push the bezel to the left to release 
the right side latches and rotate the bezel off the chassis from left to right 2.
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To reinstall the front bezel:

1. Position the chassis in the upright position. 

2. Insert the hooks on the right side of the bezel into the rectangular holes on the chassis 1 then 
rotate the bezel into place 2 so that the three tabs on the left side of the bezel and the single 
tab on the upper right corner of the bezel snap into the slots on the chassis.
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6.5 Front Drive Bezels 
Follow these steps before removing or installing a front drive bezel.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.3).

3. Remove the front bezel (Section 6.4).

6.5.1 5.25" Drive Bezel Blank
Press the two retaining tabs on the inside of the large bezel towards the outside of the bezel to 
release the bezel blank 1. At the same time, pull the bezel blank in to remove it from the front 
bezel 2. 

To install a bezel blank, reverse the removal procedure.
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6.5.2 Diskette Drive Bezel 
Press the two upper 1 or the two lower 2 tabs for the diskette drive bezel towards the center of 
the drive bezel and push the bezel out to remove it from the front bezel. 

To install a bezel or a bezel blank, reverse the removal procedure.

6.5.3 3.5" Drive Bezel Blank 
Press the two upper 1 or the two lower 2 tabs for the 3.5" drive bezel towards the center of the 
3.5" drive bezel and push the bezel blank out to remove it from the front bezel.

To install a bezel blank, reverse the removal procedure.
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6.6 Cable Management
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped 
when the parts are moved.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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6.7 Memory

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Section 5.2, “Electrostatic Discharge Information” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3). 

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Refer to Appendix F, “Memory” for the correct sequence for installing memory 
modules to get optimal performance.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. It may be easier to install a memory module in some cases if the main 
power cable from the power supply to the system board is temporarily disconnected.

4. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

6.8 Expansion Cards
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. On the rear of the computer, a sliding slot cover lock secures the expansion card brackets and 
expansion slot covers in place. Remove the thumbscrew that holds the slot cover lock in 
place 1 and slide the slot cover lock away from the brackets 2 so that they are no longer 
secured by the lock.
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4. Before installing an expansion card, remove the expansion slot cover or the existing 
expansion card.

✎ Before removing an installed expansion card, disconnect any cables that may be attached to the 
expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate 
expansion slot cover on the back of the chassis. Pull the slot cover straight up from the 
socket then away from the inside of the chassis.

b. If removing a standard PCI expansion card, hold the card at each end, and carefully rock 
it back and forth until the connectors pull free from the socket. Pull the expansion card 
straight up from the socket 1 then away from the inside of the chassis 2 to release it 
from the chassis frame. Be sure not to scrape the card against the other components.
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c. If removing a PCI Express x16 card, pull the retention arm on the back of the expansion 
socket away from the card and carefully rock the card back and forth until the connectors 
pull free from the socket. Pull the expansion card straight up from the socket then away 
from the inside of the chassis to release it from the chassis frame. Be sure not to scrape 
the card against the other components.

5. If not replacing the old expansion card with a new expansion card, install an expansion slot 
cover to close the open slot. Insert the metal slot cover in the opened slot and slide the slot 
cover lock down to secure the slot cover in place.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot 
cover for proper cooling of internal components during operation.
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6. If replacing or adding a new expansion card, hold the card just above the expansion slot on 
the system board then move the card toward the rear of the chassis 1 so that the bracket on 
the card is aligned with the open slot on the rear of the chassis. Press the card straight down 
into the expansion slot on the system board 2.

✎ When installing an expansion card, press firmly on the card so that the whole connector seats 
properly in the expansion card slot.

7. If you are replacing an expansion card, store the old card in the anti-static packaging that 
contained the new card.

8. While holding the expansion card bracket against the chassis, slide the slot cover lock down 
toward the expansion card brackets and slot covers 1 to secure them in place and replace the 
thumbscrew 2 that secures the slot cover lock.

9. Connect external cables to the installed card, if needed. Connect internal cables to the system 
board, if needed. 
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6.9 Drives
The computer supports up to six drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15 
screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

6.9.1 Drive Positions 

Drive Positions
Item Description

1 Two 5.25-inch, half-height bays for optional drives

2 Two standard 3.5-inch, one-third height bays (1.44-MB diskette drive shown)*

3 Two internal 3.5-inch, one-third height bays for hard drives

*A 3.5-inch diskette drive or zip drive may be installed in this bay but the correct bezel must be 
installed to ensure proper air flow.
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6.9.2 Removing a Drive 
1. Remove any removable media, such as a compact disc or diskette, from the drive.

2. Prepare the computer for disassembly (Section 6.1).

3. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

4. Remove the front bezel (Section 6.4).

5. Disconnect the power and data cables from the back of the drive, as shown in the following 
illustrations. 

Disconnecting Optical Drive Cables 

Disconnecting Diskette Drive Cables 
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Disconnecting Hard Drive Cables 

✎ Some products use straight cable connectors while others use right angle connectors.

Releasing the Drives
6. A latch drive bracket with release tabs secures the drives in the drive bay. Lift the release tab 

on the latch drive bracket 1 for the drive you want to remove, then slide the drive from its 
drive bay 2.

7. Remove the four guide screws (two on each side) from the old drive. You will need these 
screws to install a new drive. 
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6.9.3 Installing a Drive 

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. Refer to Section 5.2, “Electrostatic Discharge Information” for more 
information about preventing electrostatic damage.

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Install four guide screws (two on each side) into the new drive. The screws help guide the 
drive into its proper position in the bay. 

❏ If this is a new installation, guide screws are provided on the front of the chassis under 
the front bezel.

❏ If this is a replacement drive, use the screws removed from the old drive.

✎ There are a total of eight extra guide screws on the front of the chassis. Four have U.S. threads 
and four have metric threads. Metric screws have a black finish. U.S. threaded screws have a 
silver finish. Make sure to install the appropriate guide screws into the drive.

2. Align the guide screws with the guide slots, then slide the drive into the drive bay, making 
sure it is fully seated. 
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3. Reconnect the power and data cables to the drive as shown in the following illustrations.

✎ Refer to Chapter 4, “Serial and Parallel ATA Drive Guidelines and Features” for information on 
attaching the cabling to get optimum performance.

Connecting Optical Drive Cables 

Connecting Diskette Drive Cables 
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Connecting Hard Drive Cables 

✎ Some products use straight cable connectors while others use right angle connectors.

4. Install the front bezel (Section 6.4).

5. Install the access panel (Section 6.3).

6. Turn on the computer.

✎ If you replaced the primary hard drive, the Restore Plus! CD may be used to restore the operating 
system, software drivers, and/or any software applications that were preinstalled on the 
computer. Follow the instructions in the guide included with the Restore Plus! CD. When the 
restore process has completed, reinstall any personal files that were backed up before replacing 
the hard drive.
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6.10 Chassis Fan 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Disconnect the power cable that connects the chassis fan to the system board 1.

4. Remove the four screws from the exterior rear of the chassis that secure the fan 2. 

5. Remove the fan from the chassis 3.

To install the chassis fan, reverse the removal procedure.
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6.11 Front I/O Panel Housing Assembly 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Disconnect three attaching cables from the system board: the power switch/LED cable, the 
front USB cable, and the front audio cable.

4. Remove the two screws that secure the housing to the chassis 1 then pull the housing away 
from the chassis 2.

To install the housing assembly, reverse the removal procedures.
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6.12 Front I/O Devices 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Remove the front I/O panel assembly (Section 6.11).

4. Remove the two screws that hold the USB and audio port assembly in place 1.

5. Remove the I/O device assembly from the I/O panel by pushing it out of the housing 2.

To install the I/O devices, reverse the removal procedures and then reinstall the housing 
assembly.
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6.13 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Remove the front I/O panel assembly (Section 6.11).

4. Squeeze the switch holder retaining clips together 1 and push the switch assembly out of the 
front I/O panel housing 2.

5. Place the switch holder with the switch installed into the inside of the front I/O panel housing 
and position the legs of the retaining clip into the clip slots. Press firmly so that the clips will 
penetrate the slot openings and latch into place. If one clip will not easily engage, it may be 
necessary to use the end of a ball point pen (or another thin, stiff object) to compress the clip 
leg while inserting it into the clip slot.

6. Reconnect the housing assembly to the front of the chassis and reconnect the cables to the 
system board.
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6.14 Heatsink 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Disconnect the heatsink fan cable from the system board. 

4. Disconnect the four-pin power cable from the system board to make it easier to access the 
heatsink.

5. Loosen the four captive screws 1 that secure the heatsink to the system board tray.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

6. Lift the heatsink from atop the processor 2 and set it on its side to keep from contaminating 
the work area with thermal grease.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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6.15 Processor 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer cover (Section 6.3).

3. Disconnect the heatsink control cable from the system board and remove the heatsink 
(Section 6.14).

4. Rotate the locking lever to its full open position 1.

5. Raise and rotate the microprocessor retainer to its fully open position 2.

6. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 6.

3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad 
provided in the spares kit.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply thermal 
grease to the top of the processor from the syringe supplied in the spares kit.
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4. Apply the thermal grease provided in the spares kit to the top of the processor and install the 
heatsink atop the processor.

5. Go to step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the four captive screws 
and attach the heatsink control cable to the system board. 

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be 
found on the Web at: http://h18000.www1.hp.com/support/files.
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6.16 Speaker 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Move/remove any components necessary to gain access to the speaker.

4. Disconnect the speaker wire from the system board connector.

5. Remove the two plastic push pins that secure the speaker to the chassis.

6. Remove the speaker by lifting it up and out of the retaining clips.

To install the speaker, reverse the removal procedures.
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6.17 Power Supply

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Disconnect all power cables from the mass storage devices and from the system board.

4. Remove the screws that connect the power supply to the chassis 1.
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5. Pull the power supply towards the front of the chassis while depressing the two sets of 
retaining clips 1 to allow the power supply to move far enough to lift it from the chassis 2.

To install the power supply, reverse the removal procedure.
6–30 390812-001 Service Reference Guide, dx7200



Removal and Replacement Procedures— Microtower (MT) Chassis
6.18 System Board 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

3. Remove all PCI and PCI Express expansion boards (Section 6.8).

4. Disconnect all cables connected to the system board, noting their location for reinstallation.

5. Remove the 3-1/4" drives from the drive cage to make it easier to handle the system board.

6. Remove the eight screws that secure the system board to the chassis 1, then slide the system 
board towards the front of the chassis to remove it 2.

To install the system board, reverse the removal procedures.
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6.19 Battery
The battery that comes with your computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup (F10) 
Utility Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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6.19.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel (Section 6.3).

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
Service Reference Guide, dx7200 390812-001 6–33



Removal and Replacement Procedures— Microtower (MT) Chassis
6.19.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery. When the battery pops up, lift it out 1.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

3. Replace the computer cover or access panel (Section 6.3).

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.19.3 Type 3 Battery Holder
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel (Section 6.3).

4. Plug in the computer and turn on power.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7
Removal and Replacement Procedures— 

Slim Tower (ST) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

7.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,”for initial 
safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 7.2, 
“Unlocking the Smart Cover Lock,” and Section 7.4, “External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette or compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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8. Lift the computer off the stand.

9. Lay the computer on its side (with the computer cover facing up) before removing the 
computer cover and installing hardware.
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7.2 Unlocking the Smart Cover Lock 
If you have locked the Smart Cover Lock use Computer Setup to unlock the lock. Refer to the 
Desktop Management Guide on the Documentation and Diagnostics CD for more information 
about the Smart Cover Lock.

If you cannot access Computer Setup to unlock the cover you will need to remove the locking 
solenoid by using the Smart Cover FailSafe Key (Spare part number 166527-001 or 
166527-002). Once the solenoid has been deactivated or removed the access panel can be 
removed.

The Smart Cover FailSafe Key will be needed in any of the following circumstances:

■ Power outage

■ Startup failure

■ Processor or power supply failure

■ Lost password

To open the computer cover with the Smart Cover Lock engaged:

1. Prepare the computer for disassembly (Section 7.1).

2. Using the Smart Cover FailSafe Key, remove the tamper-proof screw 1 that secures the 
Smart Cover Lock to the inside of the chassis.

3. Push the metal arm that wraps around the air vent grid up and back 2 to free the Smart Cover 
Lock from the chassis.

4. Remove the computer cover (Section 7.5).
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To reattach the Smart Cover Lock:

1. Install the Smart Cover Lock assembly on the inside of the rear panel with the metal arm 1 
wrapped around the air vent grid on the back of the chassis.

2. Use the supplied tamper-resistant screw 2 to secure the Smart Cover Lock to the chassis.
7–4 390812-001 Service Reference Guide, dx7200



Removal and Replacement Procedures— Slim Tower (ST) Chassis
7.3 Hood Sensor 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5). 

3. Remove the special security clip (Section 7.4.1) from the top rear corner of the power supply 
cage. 

4. Raise the power supply to its full upright position.

5. Disconnect the hood sensor cable from the system board.

6. Slide the hood sensor switch mounted on the power supply towards the outside of the 
computer 1 and lower it through the slot 2.

To install the hood sensor, reverse the removal procedure.
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7.4 External Security Devices

7.4.1 Security Clip
A special clip is required to secure the computer from intrusion. This clip must be installed 
before installing the computer cover.

7.4.2 Cable Lock 
The cable lock may be used to secure the computer cover to the chassis and, at the same time, 
secure the computer to a fixed object. 

Insert the cable lock in the location shown below.
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7.4.3 Padlock 
A padlock may be used by itself to secure the computer cover to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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7.5 Computer Cover 
1. Prepare the computer for disassembly (Section 7.1).

Ä
CAUTION: Before removing the computer cover, ensure that the computer is turned off and that the 
power cord is disconnected from the electrical outlet.

1. Press the buttons on the left and right sides of the computer 1.

2. Slide the computer cover towards the front of the computer until it stops 2, then lift it up and 
off the chassis.

To install the computer cover, reverse the removal procedure.
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7.6 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the drive bezel by pushing the top tab on the right side of the larger front bezel as 
shown 1 and rotating the drive bezel away from the larger front bezel 2. 

✎ The drive bezel will vary depending on the computer configuration.

4. Install a bezel or a bezel blank by pushing the bezel into place.
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There are three drive bezel inserts that are available. 

Item Description

1 Diskette drive bezel

2 Hard drive bezel

3 3.5” drive bezel
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7.7 Cable Management 
The Slim Tower chassis is a very compact computer and proper routing of the internal cables is 
critical to the operation of the computer. Follow good cable management practices when working 
inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of movable or rotating parts like the power supply and drive cage to 
prevent them from being cut or crimped when the component is lowered into its normal 
position.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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7.8 Memory

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Section 5.2, “Electrostatic Discharge Information” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Refer to Appendix F, “Memory” for the correct sequence for installing memory 
modules to get optimal performance.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

4. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.

5. Repeat steps 3 and 4 for any additional modules that you want to install.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.

7.9 Vertically Oriented Expansion Card 

7.9.1 Expansion Card Retainer 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

4. Remove the single screw that keeps the card retainer in place 2 and slide the retainer to the 
left to remove it from the chassis 3.

To install the card retainer, reverse the removal procedure.
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7.9.2 PCI Expansion Card 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Identify the slot into which you want to insert the expansion card.

4. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

5. Remove the slot cover by sliding it up and out of the computer 2.
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6. Install the expansion card by sliding the card under the slot cover retention latch then 
pressing the card down into the slot on the system board.

✎ Be sure not to scrape other components in the chassis when installing an expansion card.

7. Rotate the slot cover retention latch back in place to secure the expansion card.

✎ When you install an expansion card, make sure the metal bracket on the card slides into the slot 
on the back of the computer then press down firmly on the card so that the whole connector seats 
properly in the expansion card slot.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.9.3 PCI Express Expansion Card
To remove a PCI Express expansion card:

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5). 

3. Release the slot cover retention latch on the back of the computer that secures the PCI slot 
covers by lifting the green tab on the latch and rotating the latch to the open position.

4. Pull the retention arm on the back of the PCI Express expansion socket away from the card 
(on x16 card socket only) and carefully rock the card back and forth until the connectors pull 
free from the socket. Pull the expansion card straight up from the socket then away from the 
inside of the chassis. Be sure not to scrape the card against the other components.

5. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot.

6. Rotate the slot cover retention latch back in place to secure the expansion cards and 
expansion slot covers.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.10 Drives
A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

7.10.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions
Item Description

1 3.5-inch, internal, standard hard drive bay

2 3.5-inch drive bay (1.44-MB diskette drive shown)*

3 5.25-inch drive bay for optional drives

*A 3.5-inch diskette drive, hard drive, or Zip drive may be installed in this bay but the correct 
bezel must be installed to ensure proper air flow. 
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7.10.2 Optical Drive 

✎ An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD Combo 
drive.

1. Remove any removable media, such as a CD or DVD, from the drive.

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5). 

4. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

5. Disconnect the power and data cables from the rear of the optical drive.
7–18 390812-001 Service Reference Guide, dx7200



Removal and Replacement Procedures— Slim Tower (ST) Chassis
6. Rotate the drive cage down to its normal position before trying to remove the drive. 

7. Press the green drive retainer latch and slide the drive forward and lift it from the drive cage.

To replace the drive, reverse the removal procedure.

✎ When replacing the drive, transfer the four screws from the old drive to the new one. The screws 
take the place of drive rails.

Ä
CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal 
components of the drive.
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7.10.3 External 3.5-inch Drive 
1. Remove any removable media, such as a diskette, from the drive.

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5).

4. Remove the optical drive (Section 7.10.2).

5. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

6. Disconnect the signal and power cables from the drive. The other end of the cables should 
remain connected to the system board. (Diskette drive is shown.)

7. Rotate the drive cage down to its normal position before trying to remove the drive.
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8. Press the green drive retention latch 1 located on the side of the diskette drive to disengage 
the drive from the drive cage and slide the diskette drive forward approximately 6mm 
(1/4 inch) 2.

9. Lift the rear of the drive up so that the rear guide screws clear the top of the drive cage 1. 
As the drive rises it automatically slides forward until it is free from the drive cage 2.

To replace the drive, reverse the removal procedure making sure you rotate the rear of the drive 
down, pivoting on the front screws.

✎ When replacing the drive, transfer the four metric screws from the old drive to the new one. The 
screws take the place of drive rails. 
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7.10.4 Primary Hard Drive 
A Torx T-15 screwdriver is needed to remove and install the guide screws on a hard drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. Refer to Section 5.2, “Electrostatic Discharge Information” for more 
information about preventing electrostatic damage.

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

✎ It is not necessary to remove the drives from the drive cage.
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4. Remove the security clip that secures the backwall to the power supply.

5. Rotate the power supply to its full upright position. 
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6. Disconnect the power 1 and data 2 cables from the back of the hard drive.

7. Pull the tab that locks the drive in place away from the drive 1, slide the hard drive toward 
the front of the computer, then lift it up and out of the bay 2.

To install a hard drive, reverse the above procedure.

✎ The replacement hard drive kit includes several data cables. Make sure to use the cable that is 
exactly the same as the factory-installed cable.

✎ If the system has only one SATA hard drive, the data cable must be connected to the blue 
connector labeled P60 SATA 0 first to avoid any hard drive performance problems.
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✎ When replacing the hard drive, transfer the four screws from the old drive to the new one. The 
screws take the place of drive rails. You will need a Torx T-15 screwdriver to remove and 
re-install the guide screws. HP has provided four extra 6-32 standard guide screws on the front of 
the chassis, under the computer cover. The 6-32 standard guide screws are silver and are used 
only for the hard drive.

✎ If you replaced the primary hard drive, insert the Restore Plus! CD to restore the operating 
system, software drivers, and any software applications that were preinstalled on the computer. 
Follow the instructions in the guide included with the Restore Plus! CD. When the restore 
process has completed, reinstall any personal files that you backed up before replacing the hard 
drive.
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7.11 Fan Shroud 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Lift up on the fan shroud to remove it from the computer.

When replacing the shroud, make sure that it does not get caught on the wires from either the fan 
or the speaker. 
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7.12 Chassis Fan 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.11).

4. Disconnect the chassis fan cable from the system board. 

5. Remove the four screws that secure the fan to the chassis, then remove the fan from the 
chassis.

To install the chassis fan, reverse the removal procedure. Be sure to orient the air flow into the 
unit. Refer to the air flow arrows on the side of the fan housing for proper air flow orientation. 
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7.13 Front I/O Devices 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the two screws that secure the front I/O device to the chassis 1.

4. Rotate the drive cage to its full upright position.

5. Disconnect the front I/O cable from the system board.

6. Push the front I/O device into the chassis 2 and snake the cable through the tunnel 3 to 
remove the device from the chassis. 

To reinstall the front I/O device, reverse the removal procedure.
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7.14 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Disconnect the power switch/LED cable from the system board. 

4. Squeeze the switch holder retaining clips together at the front of the chassis 1 and push the 
switch assembly out of the chassis 2. Push the two LEDs out of the chassis 3.

5. If necessary, the LED holders may also be removed by squeezing the clips and pushing them 
out of the front of the chassis.

To install the power switch and LEDs, reverse the removal procedure. 
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7.15 Heatsink 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.11).

4. Disconnect the fan control cable from the system board.

5. Loosen the four captive screws that secure the heatsink to the system board tray.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

6. Lift the heatsink from atop the processor and set it on its side to keep from contaminating the 
work area with thermal grease.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

Ä
CAUTION: Failure to install the fan shroud may cause the computer to overheat.
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7.16 Processor 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.11).

4. Disconnect the heatsink control cable from the system board and remove the heatsink 
(Section 7.15).

5. Rotate the locking lever to its full open position 1.

6. Raise and rotate the microprocessor retainer to its fully open position 2.

7. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 6.

3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad 
provided in the spares kit.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply thermal 
grease to the top of the processor from the syringe supplied in the spares kit.
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4. Apply the thermal grease provided in the spares kit to the top of the processor and install the 
heatsink atop the processor.

5. Go to step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the four captive screws 
and attach the heatsink control cable to the system board. 

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be 
found on the Web at: http://h18000.www1.hp.com/support/files.
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7.17 Speaker 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.11).

4. Remove the heatsink control cable and the heatsink from the system board (Section 7.15).

5. Remove any memory modules that might interfere with the screwdriver used for removing 
the speaker.

6. Disconnect the speaker wire from the system board.

7. Remove the two screws that secure the speaker to the chassis 1.

8. Rotate the top of the speaker back to clear the lip on the top of the chassis, then lift the 
speaker up and out of the chassis 2.

To install the speaker, reverse the removal procedures.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the speaker spares kit. After the alcohol has evaporated, apply 
thermal grease to the top of the processor from the syringe supplied in the speaker spares kit.
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7.18 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the security clip. 

4. Rotate the drive cage upand disconnect the power cables from all of the drives.

5. Disconnect the power cables from the system board.

6. Release the power supply cable from the cable retaining clips on the bottom of the chassis 
under the drive cage.

7. Disconnect the hood sensor from the system board and remove the sensor from the power 
supply if required (Section 7.3).
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8. Rotate the power supply to its full upright position 1, then lift the power supply straight up 
and out of the chassis 2.

To install the power supply, reverse the removal procedure.

Ä
CAUTION: When installing the power supply cables, make sure they are properly positioned so they 
are not cut by the drive cage and are not pinched by the rotating power supply.
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7.19 System Board 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove all PCI and PCI Express expansion boards (Section 7.9).

4. Remove the fan shroud from the chassis (Section 7.10).

5. Rotate the drive cage to its full upright position.

6. Remove the security clip (Section 7.4.1) and rotate the power supply to its full upright 
position.

7. Disconnect the data and power cables from the system board.
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8. Disconnect the serial port from the system board.

9. Disconnect the balance of the cables from the system board.

10. Remove the long mounting screw that secures the system board tray to the chassis.
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11. Slide the system board tray assembly towards the front of the chassis, about 1/4 inch and lift 
the system board up and out of the chassis.

12. Remove the heatsink from the system board and the system board tray (Section 7.15).

To install the system board, reverse the removal procedure.

✎ The heatsink should be installed on the system board before the system board is reinstalled in the 
chassis.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply thermal 
grease to the top of the processor from the syringe supplied in the spares kit.

✎ When reinstalling the system board it is important to secure the system board and tray to the 
chassis with the long retaining screw before performing any subsequent steps. 

Ä
CAUTION: When reconnecting the cables it is important that they be positioned so they do not interfere 
with the rotation of the drive cage or power supply.
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7.20 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C).
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup (F10) 
Utility Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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7.20.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.20.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery. When the battery pops up, lift it out 1.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.20.3 Type 3 Battery Holder
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. 
Some of these connectors may not be used on the product being serviced.

Keyboard
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Mouse
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Ethernet BNC
Connector and Icon Pin Signal

1 (Center) Data

2 (Shield) Ground
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Ethernet RJ-45
Connector and Icon Pin Signal

1 
2 
3 
4

(+) Transmit Data 
(-) Transmit Data 
(+) Receive Data 
Unused

5 
6 
7 
8

Unused 
(-) Receive Data 
Unused 
Unused

Ethernet AUI

Connector and Icon

Pin Signal Pin Signal

1 
2 
3 
4

Ground 
Negative AUI Differential Collision 
Positive AUI Differential Collision 
Negative AUI Differential Transmit

9 
10 
11 
12

Positive AUI Differential Receive 
+12V 
Ground 
Ground

5 
6 
7 
8

Positive AUI Differential Transmit 
Ground 
Ground 
Negative AUI Differential Receive

13 
14 
15 
16

Unused 
Unused 
Unused 
Unused
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Parallel Interface

Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Strobe 
Data Bit 0 
Data Bit 1

7 
8 
9

Data Bit 5 
Data Bit 6 
Data Bit 7

13 
14 
15

Select 
Auto Linefeed 
Error

4 
5 
6

Data Bit 2 
Data Bit 3 
Data Bit 4

10 
11 
12

Acknowledge 
Busy 
Paper End

16 
17 
18-25

Initialize Printer 
Select IN 
Signal Ground

Serial Interface, Powered and Non-Powered
Connector and Icon Pin Signal

1 
2 
3

Carrier Detect (12V if powered) 
Receive Data 
Transmit Data

4 
5 
6

Data Terminal Ready 
Signal Ground 
Data Set Ready

7 
8 
9

Request to Send 
Clear to Send 
Ring Indicator (5V if powered)

USB
Connector and Icon Pin Signal

1 
2 
3 
4

+5 VDC 
- Data 
+ Data 
Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio

2 (Ring) Power

3 (Shield) Ground

1 2 31 2 3
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Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Left

2 (Ring) Audio_Right

3 (Shield) Ground

Line-In Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left

2 (Ring) Audio_In_Right

3 (Shield) Ground

Line-Out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left

2 (Ring) Audio_Out_Right

3 (Shield) Ground

SCSI Low Voltage Differential/Single Ended (LVD/SE)
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-16 
17-18 
19

Ground 
TERMPWR 
Reserved

40 
41 
42

-D0 
-D1 
-D1

49-50 
51-52 
53

Ground 
TERMPW 
Reserved

60 
61 
62

-MSG 
-SEL 
-C/D

20-34 
35 
36

Ground 
-D12 
-D13

43 
44 
45

-D3 
-D4 
-D5

54 
55 
56

Ground 
-ATN 
Ground

63 
64 
65

-REQ 
-I/O 
-D

37 
38 
39

-D14 
-D15 
-DP1

46 
47 
48

-D6 
-D7 
-DP0

57 
58 
59

-BSY 
-ACK 
-RST

66 
67 
68

-D 
-D 
-D

1 2 3

1 2 3

1 2 3
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Ultra SCSI
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-11 
12 
13 
14

Ground 
Reserved 
Open 
Reserved

29 
30 
31 
32

DB3 
DB4 
DB5 
DB6

37 
38 
39 
40

Reserved 
TERMPWR 
Reserved 
Ground

45 
46 
47 
48

RST # 
MSG # 
SEL # 
C/D

15-25 
26 
27 
28

Ground 
DB0 
DB1 
DB2

33 
34 
35 
36

DB7 
DBP 
Ground 
Ground

41 
42 
43 
44

ATN # 
Ground 
BSY # 
ACK #

49 
50

REQ # 
Input/Output

External Infrared Transceiver
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Transmit 
Receive 
Ground

4 
5 
6

5V 
Mode 
Not Used

7 
8 

Not Used 
Not Used

Monitor
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Red Analog 
Green Analog 
Blue Analog

6 
7 
8

Ground 
Ground 
Ground

11 
12 
13

Not used 
DDC Serial Data 
Horizontal Sync

4 
5

Not used 
Ground

9 
10

+5V (fused) 
Ground

14 
15

Vertical Sync 
DDC Serial Clock
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ATA/ATAPI (IDE) Standard Drive Cable
Connector

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
 

MultiBay CD-ROM Adapter
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

RESDRV_ 
GROUND 
D07 
D08 
D06

18 
19 
20 
21 
22

D15 
GROUND 
(key) 
DRQ 
GROUND

35 
36 
37 
38 
39

A0 
A2 
CS1FX 
CS3FX 
DASP

52 
53 
54 
55 
56

FP05 
FP06 
FP07 
FP08 
FP09

6 
7 
8 
9 
10

D09 
D05 
D10 
D04 
D11

23 
24 
25 
26 
27

IOW 
GROUND 
IOR 
GROUND 
IOCHDRY

40 
41 
42 
43 
44

GROUND 
+5VMLOG 
-5VMOT 
GROUND 
AUDIO_L

57 
58 
59 
60 
61

FP10 
FP11 
FP12 
FP13 
FP14

11 
12 
13 
14 
15

D03 
D12 
D02 
D13 
D01

28 
29 
30 
31 
32

CABLE SELECT 
DAK 
GROUND 
IRQ 
IO16

45 
46 
47 
48 
49

A_GROUND_R 
A_GROUND_I 
audio_r 
FP01 
FP02

62 
63 
64 
65 
66

FP15 
FP16 
FP17 
FP18 
FP19

16 
17

D14 
D00

33 
34

A1 
PDIAG

50 
51

FP03 
FP04

67 
68

FP20 
FP21
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Connector Pin Assignments
24-Pin Power
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+3.3 V 
+3.3 V 
GND 
+5 V 
GND 
+5 V

7 
8 
9 
10 
11 
12

GND 
POK 
+5 Vaux 
+12 V 
+12 V 
+3.3 V

13 
14 
15 
16 
17 
18

+3.3 V 
-12 V 
GND 
PSON 
GND 
GND

19 
20 
21 
22 
23 
24

GND 
open 
+5 V 
+5 V 
+5 V 
GND

24

12

13

1

24-Pin MicroFit Power
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+5 Vaux 
GND 
+5 V 
+5 V 
PS_ON 
GND

7 
8 
9 
10 
11 
12

PWRGD 
+3.3 V 
+3.3 V 
Tach 
GND 
Fan-CMD

13 
14 
15 
16 
17 
18

+12 V 
+5 V Sense 
GND 
+5 V 
+5 V 
+3.3 V

19 
20 
21 
22 
23 
24

GND 
+3.3 Sense 
+3.3 V 
+3.3 V 
GND 
-12 V

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1 GND

2 GND

3 +12 V CPU

4 -12 V CPU

24

12

13�

1
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Connector Pin Assignments
 

6-Pin Power (for CPU)
Connector and Icon Pin Signal

1 GND

2 GND

3 GND

4 12 V CPU

5 12 V CPU

6 +12 V

64

SATA Data and Power 

Drive Connector

Pin Signal Pin Signal Pin Signal Pin Signal

S1
S5

Ground
B-

S2
S6

A+
B+

S3
S7

A-
Ground

S4 Ground

P1
P5
P9
P13

V 3.3
Ground
V 5
V 12

P2
P6
P10
P14

V 3.3
Ground
Ground
V 12

P3
P7
P11
P15

V 3.3
V 5
Reserved
V 12

P4
P8
P12

Ground
V 5
Ground

*S = Data, P = Power
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Connector Pin Assignments
PCI Express 
x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

PRSNT1# 
+12V 
+12V 
GND 
JTAG2

6 
7 
8 
9 
10

JTAG3 
JTAG4 
JTAG5 
+3.3v 
+3.3v

11 
12 
13 
14 
15

PERST# 
GND 
REFCLK+ 
REFCLK- 
GND

16 
17 
18 
19 
20

PERp0 
PERn0 
GND 
RSVD 
GND

21 
22 
23 
24 
25

PERp1 
PERn1 
GND 
GND 
PERp2

26 
27 
28 
29 
30

PERn(2) 
GND 
GND 
PERp3 
PERn3

31 
32 
33 
34 
35

GND 
RSVD 
RSVD 
GND 
PERp4

36 
37 
38 
39 
40

PERn4 
GND 
GND 
PERp5 
PERn5

41 
42 
43 
44 
45

GND 
GND 
PERp6
PERn6 
GND

46 
47 
48 
49 
50

GND 
PERp7 
PERn7 
GND 
RSVD

51 
52 
53 
54 
55

GND 
PERp8 
PERn8 
GND 
GND

56 
57 
58 
59 
60

PERp9 
PERn9 
GND 
GND 
PERp10

61
62 
63 
64 
65

PERn10 
GND 
GND 
PERp11 
PERn11

66 
67 
68 
69 
70

GND 
GND 
PERp12 
PERn12 
GND

71 
72 
73 
74 
75

GND 
PERp13 
PERn13 
GND 
GND

76 
77 
78 
79 
80

PERp14 
PERn14 
GND 
GND 
PERp15

81 
82

PERn15 
GND

Pin B information is on the next page

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82 
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Connector Pin Assignments
Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

+12V 
+12V 
RSVD 
GND 
SMCLK

6 
7 
8 
9 
10

SMDAT 
GND 
+3.3v 
JTAG1 
3.3vAux

11 
12 
13 
14 
15

WAKE# 
RSVD 
GND 
PETp0 
PETn0

16 
17 
18 
19 
20

GND 
PRSNT2# 
GND 
PETp1 
PETn1

21 
22 
23 
24 
25

GND 
GND 
PETp2 
PETn2 
GND

26 
27 
28 
29 
30

GND 
PETp3 
PETn3 
GND
RSVD

31 
32 
33 
34 
35

PRSNT2# 
GND 
PETp4 
PETn4 
GND

36 
37 
38 
39 
40

GND 
PETp5 
PETn5 
GND 
GND

41 
42 
43 
44 
45

PETp6 
PRTn6 
GND 
GND 
PETp7

46 
47 
48 
49 
50

PETn7 
GND 
PRSNT2# 
GND 
PETp8

51 
52 
53 
54 
55

PETn8 
GND 
GND 
PETp9 
PETn9

56 
57 
58 
59 
60

GND 
GND 
PETp10 
PETn10 
GND

61 
62 
63 
64 
65

GND 
PETp11 
PETn11 
GND 
GND

66 
67 
68 
69 
70

PETp12 
PETn12 
GND 
GND 
PETp13

71 
72 
73 
74 
75

PETn13 
GND 
GND 
PETp14 
PETn14

76 
77 
78 
79 
80

GND 
GND 
PETp15 
PETn15 
GND

81 
82

PRSNT2# 
RSVD

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82

PCI Express 
x1, x4, x8, and x16 PCI Express Connector
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Connector Pin Assignments
DVI Connector
Connector and Icon

Pin Signal Pin Signal

1 
2 
3 
4

T.M.D.S. Data2- 
T.M.D.S. Data2+ 
T.M.D.S. Data2/4 Shield 
T.M.D.S. Data4-

13 
14 
15 
16

T.M.D.S. Data3+ 
+5V Power 
Ground (for +5V) 
Hot Plug Detect

5 
6 
7 
8

T.M.D.S. Data4+ 
DDC Clock 
DDC Data 
No Connect

17 
18 
19 
20

T.M.D.S. Data0- 
T.M.D.S. Data0+ 
T.M.D.S. Data0/5 Shield 
T.M.D.S. Data5-

9 
10 
11 
12

T.M.D.S. Data1- 
T.M.D.S. Data1+ 
T.M.D.S. Data1/3 Shield 
T.M.D.S. Data3-

21 
22 
23 
24

T.M.D.S. Data5+ 
T.M.D.S. Data Shield 
T.M.D.S. Clock+ 
T.M.D.S. Clock-
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B
Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch 
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 
volts AC. Power supplies on those computers that do not have external power switches are 
equipped with internal switches that sense the incoming voltage and automatically switch to the 
proper voltage.

The power cord set received with the computer meets the requirements for use in the country 
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you 
use the computer.

General Requirements
The requirements listed below are applicable to all countries: 

1. The power cord must be approved by an acceptable accredited agency responsible for 
evaluation in the country where the power cord set will be installed. 

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a 
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system. 

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the 
cord must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items 
placed upon it or against it. Particular attention should be paid to the plug, electrical outlet, and 
the point where the cord exits from the product.

Å
WARNING: Do not operate this product with a damaged power cord set. If the power cord set is 
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

Ä
CAUTION: Do not use the power cord received with this product on any other products.
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Power Cord Set Requirements
Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country
Accrediting

Agency Country
Accrediting

Agency

Australia (1) 
Austria (1) 
Belgium (1)  
Canada (2)

EANSW 
OVE 
CEBC 
CSA

Italy (1) 
Japan (3) 
Norway (1) 
Sweden (1)

IMQ 
METI 
NEMKO 
SEMKO

Denmark (1) 
Finland (1)  
France (1)  
Germany (1) 

DEMKO 
SETI 
UTE 
VDE

Switzerland (1) 
United Kingdom (1) 
United States (2) 

SEV 
BSI 
UL 

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of 
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug 
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P 
(15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration 
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or 
VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole grounding type 
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C
POST Error Messages

POST Error Messages
An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs 
when the system is turned on, checking assemblies within the computer and reporting any errors 
found. 

Not all computers use all of the codes listed.

POST Error Messages 

Screen Message Probable Cause Recommended Action

101-Option ROM 
Checksum Error

System ROM or 
expansion board option 
ROM checksum.

Verify the correct ROM.
Flash the ROM if needed.
If an expansion card was recently 
added, remove it and see if the problem 
remains. 
Clear CMOS.
If the message disappears, there may be 
a problem with the expansion card.
Replace the system board.

103-System Board 
Failure

DMA or timers. Clear CMOS.
Remove expansion boards.
Replace the system board.

110-Out of Memory 
Space for Option 
ROMs

Recently added PCI 
expansion card contains 
an option ROM too large 
to download during 
POST.

If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.
In Computer Setup, disable the NIC PXE 
Option ROM Download to prevent PXE 
option ROM for the internal NIC from 
being downloaded during POST to free 
more memory for an expansion card’s 
option ROM. Internal PXE option ROM is 
used for booting from the NIC to a PXE 
server.
Ensure that the ACPI/USB Buffers @ Top 
of Memory setting in Computer Setup is 
enabled.
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POST Error Messages
162-System Options 
Not Set

Configuration incorrect.
RTC (real-time clock) 
battery may need to be 
replaced. 

Run Computer Setup (F10 Setup) and 
check configuration of Onboard 
Devices.
Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system.
If the problem persists, replace the RTC 
battery.

163-Time & Date Not 
Set

Invalid time or date in 
configuration memory. 
RTC (real-time clock) 
battery may need to be 
replaced. 

Set the date and time under Control 
Panel or in F10 Setup depending on 
the operating system. 
If the problem persists, replace the RTC 
battery. 

CMOS jumper may not 
be properly installed.

Check for proper placement of the 
CMOS jumper, if applicable.

164-Memory Size Error Memory amount has 
changed since the last 
boot (memory added or 
removed).

Press the F1 key to save the memory 
changes.

Memory configuration is 
incorrect.

Run Computer Setup (F10 Setup).
Make sure memory module(s) (if any) are 
installed properly.
If third party memory has been added, 
test using HP-only memory.
Verify proper memory module type.

201-Memory Error RAM failure. Run Computer Setup (F10 Setup) or 
Windows utilities.
Ensure memory and continuity modules 
are installed correctly.
Verify proper memory module type.
Remove and replace the identified faulty 
memory module(s).
If the error persists after replacing 
memory modules, replace the system 
board.

202-Memory Type 
Mismatch

Memory modules do not 
match each other.

Replace memory modules with matched 
sets.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
207-ECC Corrected 
Single Bit Errors in 
DIMM slot(s)

Memory module is 
experiencing correctable 
errors.

If additional memory was recently 
added, remove it to see if the problem 
remains.
If memory module was not recently 
installed and frequency of error message 
increases, consider replacing the 
module.
Check product documentation for 
memory support information.

213-Incompatible 
memory Module in 
memory Socket(s)  
X,X, X

A memory module in 
memory socket identified 
in the error message is 
missing critical SPD 
information, or is 
incompatible with the 
chipset.

Verify proper memory module type.
Try another memory socket.
Replace memory with a module 
conforming to the SPD standard.

214-DIMM 
Configuration Warning

Populated DIMM 
configuration is not 
optimized.

Rearrange the DIMMS so that each 
channel has the same amount of 
memory.

216-Memory Size 
Exceeds Maximum 
Supported

Recently added memory 
module(s) exceeds the 
supported memory 
amount for the system.

If additional memory was recently 
added, remove it to see if the problem 
remains.
Check product documentation for 
memory support information.

219-ECC Memory 
Module Detected. ECC 
Modules not supported 
on this platform

Recently added memory 
module(s) support ECC 
memory error correction.

If additional memory was recently 
added, remove it to see if the problem 
remains.
Check product documentation for 
memory support information.

301-Keyboard Error Keyboard failure. Reconnect keyboard with computer 
turned off.
Check connector for bent or missing 
pins.
Ensure that none of the keys are 
depressed.
Replace keyboard.

303-Keyboard 
Controller Error

I/O board keyboard 
controller.

Reconnect keyboard with computer 
turned off.
Replace the system board.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
304-Keyboard or 
System Unit Error

Keyboard failure. Reconnect the keyboard with computer 
turned off.
Ensure that none of the keys are 
depressed.
Replace keyboard.
Replace system board. 

404-Parallel Port 
Address Conflict 
Detected

Both external and internal 
ports are assigned to 
parallel port X.

Remove any parallel port expansion 
cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup.

410-Audio Interrupt 
Conflict

IRQ address conflicts with 
another device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

411-Network Interface 
Card Interrupt Conflict

IRQ address conflicts with 
another device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

501-Display Adapter 
Failure

Graphics display 
controller.

Reseat the graphics card (if applicable).
Clear CMOS.
Verify that the monitor is attached and 
turned on.
Replace the graphics card (if 
applicable).

510-Splash Screen 
image corrupted

Splash Screen image has 
errors.

Reflash the system ROM with the latest 
BIOS image

511-CPU, CPUA, or 
CPUB Fan not detected

Fan is not connected or 
may have malfunctioned.

Reseat fan cable.
Reseat the fan.
Replace the fan.

512-Chassis, rear 
chassis, or front chassis 
fan not detected

Fan is not connected, 
may have malfunctioned.

Reseat chassis, rear chassis, or front 
chassis fan cable.
Reseat chassis, rear chassis, or front 
chassis fan.
Replace chassis, rear chassis, or front 
chassis fan.

514-CPU or Chassis 
Fan not detected.

CPU or chassis fan is not 
connected or may have 
malfunctioned.

Reseat CPU or chassis fan.
Reseat fan cable.
Replace CPU or chassis fan.

601-Diskette Controller 
Error

Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

Run Computer Setup (F10 Setup).
Check and/or replace cables.
Clear CMOS.
Replace diskette drive. 
Replace the system board.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
605-Diskette Drive Type 
Error

Mismatch in drive type. Run Computer Setup (F10 Setup).
Disconnect any other diskette controller 
devices (tape drives).
Clear CMOS.

610-External Storage 
Device Failure

External tape drive not 
connected.

Reinstall tape drive or press F1 and 
allow system to reconfigure without the 
drive.

611-Primary Floppy Port 
Address Assignment 
Conflict

Configuration error. Run Computer Setup and check the 
configuration in Advanced > 
Onboard Devices.

660-Display cache is 
detected unreliable

Integrated graphics 
controller display cache 
is not working properly 
and will be disabled.

Replace system board if minimal 
graphics degrading is an issue.

912-Computer Cover 
Has Been Removed 
Since Last System Start 
Up

Computer cover was 
removed since the last 
system startup.

No action required.

914-Hood Lock Coil is 
NOT connected

Smart Cover Lock 
mechanism is missing or 
not connected.

Reconnect or replace hood locking 
mechanism.
Reseat or replace hood locking 
mechanism cable.

917-Front Audio not 
Detected

Front audio harness has 
been detached or 
unseated from the system 
board.

Reconnect or replace front audio 
harness.

918-Front USB Not 
Connected

Front USB harness has 
been detached or 
unseated from system 
board.

Reconnect or replace front USB harness.

919-Front Panel, 
MultiPort, and/or 
MultiBay Risers not 
Detected.

Riser card has been 
removed or has not been 
reinstalled properly in the 
system.

Unplug computer and install/reinstall 
riser cord.

921-Device in PCI 
Express slot failed to 
initialize.

There is an 
incompatibility/problem 
with this device and the 
system or PCI Express Link 
could not be retrained to 
an x1.

Try rebooting the system. If the error 
reoccurs, the device may not work with 
this system.

1151-Serial Port A 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM1.

Remove any serial port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
1152-Serial Port B 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM2.

Remove any serial port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

1155-Serial Port 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to same IRQ.

Remove any serial port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup or Windows utilities.

1201-System Audio 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

1202-MIDI Port Address 
Conflict Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

1203-Game Port 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

1720-SMART Hard 
Drive Detect Imminent 
Failure

Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an erroneous 
error message.)

Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test if applicable.
Apply firmware patch if applicable. (visit 
www.hp.com/support)
Back up contents and replace hard drive.

1785-MultiBay 
incorrectly installed  

(for integrated MultiBay/ 
USDT systems)
MultiBay device not 
properly seated.
or
MultiBay riser not 
properly seated. 

Ensure the MultiBay device is fully 
inserted.
Ensure the MultiBay riser is properly 
seated.

1794-Inaccessible 
devices attached to 
SATA 1 and/or SATA 3

A device is attached to 
SATA 1 and/or SATA 3.
Devices attached to these 
connectors will be 
inaccessible while “SATA 
Emulation” is set to 
“Combined IDE 
Controller” in Computer 
Setup.

If using Windows 2000 or Windows XP, 
change “SATA Emulation” to “Separate 
IDE Controller” in Computer Setup.
If not using Windows 2000 or Windows 
XP, relocate the affected devices to SATA 
0 or SATA 2 (if available).
Remove the affected devices from SATA 
1 and SATA 3.

POST Error Messages (Continued)
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POST Error Messages
1796-SATA Cabling 
Error

One or more SATA 
devices are improperly 
attached. For optimal 
performance, the SATA 0 
and SATA 1 connectors 
must be used before 
SATA 2 and SATA 3.

Ensure SATA connectors are used in 
ascending order. For one device, use 
SATA 0. For two devices, use SATA 0 
and SATA 1. For three devices, use SATA 
0, SATA1, and SATA 2.

1800-Temperature Alert Internal temperature 
exceeds specification.

Check that computer air vents are not 
blocked and the processor cooling fan is 
running.
Verify processor speed selection.
Replace the processor.
Replace the system board.

1801-Microcode Patch 
Error

Processor not supported 
by ROM BIOS.

Upgrade BIOS to proper version.
Change the processor.

1802-Processor Not 
Supported

Recently installed 
processor may not be 
supported by the system 
board.

If processor was recently replaced, 
restore the original processor to see if the 
problem remains.
Check product documentation for 
processor support information.

Invalid Electronic Serial 
Number.

Electronic serial number 
has become corrupted.

Run Computer Setup. If Setup already 
has data in the field or will not allow the 
serial number to be entered, download 
from http://www.hp.com and run 
SP5572.EXE (SNZERO.EXE).
Run Computer Setup and try to enter 
serial number under Security, System ID, 
then save changes.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
Network Server Mode 
Active and No 
Keyboard Attached

Keyboard failure while 
Network Server Mode 
enabled.

Reconnect keyboard with computer 
turned off.
Check connector for bent or missing 
pins.
Ensure that none of the keys are 
depressed.
Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and diagnostic 
utilities.

System will not boot 
without fan.

CPU fan not installed or 
disconnected in VSFF 
chassis.

Open hood, press the power button, and 
see if the processor fan spins. If not 
spinning, make sure the fan cable is 
plugged into the system board. Ensure 
the heatsink is properly seated.
If the heatsink is properly installed and 
the fan connected but does not spin, 
replace the heatsink-fan assembly.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Error Messages
POST Diagnostic Front Panel LEDs and Audible Codes
This section covers the front panel LED codes as well as the audible codes that may occur before 
or during POST that do not necessarily have an error code or text message associated with them.

✎ If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes.

✎ Recommended actions in the following table are listed in the order in which they should be 
performed.

✎ Beeps will occur only for 5 iterations and then stop. LEDs will continue to blink until corrective 
action is taken.

POST Diagnostic Front Panel LEDs and Audible Codes 

Activity Beeps Possible Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds.

None Computer in 
Suspend to RAM 
mode (some 
models only) or 
normal Suspend 
mode.

None required. Press any key or move the 
mouse to wake the computer.

Red Power LED 
flashes two times, 
once every 
second, followed 
by a two second 
pause.

2 Processor thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The heatsink/fan 
assembly is not 
properly attached 
to the processor. 

Ensure that the computer air vents are not 
blocked and the processor cooling fan is 
running.
Open hood, press power button, and see 
if the processor fan spins. If the processor 
fan is not spinning, make sure the fan's 
cable is plugged onto the system board 
header. Ensure the fan is fully/properly 
seated or installed.
If fan is plugged in and seated properly, 
but is not spinning, then replace processor 
fan.
Reseat processor heatsink and verify that 
the fan assembly is properly attached.
Contact an authorized reseller or service 
provider.

Red Power LED 
flashes three times, 
once every 
second, followed 
by a two second 
pause.

3 Processor not 
installed (not an 
indicator of bad 
processor).

Check to see that the processor is present.
Reseat the processor.
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POST Error Messages
Red Power LED 
flashes four times, 
once every 
second, followed 
by a two second 
pause.

4 Power failure 
(power supply is 
overloaded).

Open the hood and ensure the power 
supply cable is seated into the connector 
on the system board.
Check if a device is causing the problem 
by removing ALL attached devices (such as 
hard, diskette, or optical drives, and 
expansion cards). Power on the system. If 
the system enters the POST, then power off 
and replace one device at a time and 
repeat this procedure until failure occurs. 
Replace the device that is causing the 
failure. Continue adding devices one at a 
time to ensure all devices are functioning 
properly.
Replace the power supply.
Replace the system board.

Red Power LED 
flashes five times, 
once every 
second, followed 
by a two second 
pause.

5 Pre-video memory 
error.

Reseat DIMMs. Power on the system.
Replace DIMMs one at a time to isolate 
the faulty module.
Replace third-party memory with HP 
memory.
Replace the system board.

Red Power LED 
flashes six times, 
once every 
second, followed 
by a two second 
pause.

6 Pre-video 
graphics error. 

For systems with a graphics card:
Reseat the graphics card. Power on the 
system.
Replace the graphics card.
Replace the system board.
For systems with integrated graphics, 
replace the system board.

Red Power LED 
flashes seven 
times, once every 
second, followed 
by a two second 
pause.

7 System board 
failure (ROM 
detected failure 
prior to video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every 
second, followed 
by a two second 
pause.

8 Invalid ROM 
based on bad 
checksum.

Reflash the ROM with the latest BIOS 
image. See the “ROM Flash” section of the 
Desktop Management Guide on the 
Documentation and Diagnostics CD.
Replace the system board.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes nine times, 
once every 
second, followed 
by a two second 
pause.

9 System powers on 
but is unable to 
boot.

Check that the voltage selector, located on 
the rear of the power supply (some 
models), is set to the appropriate voltage. 
Proper voltage setting depends on your 
region.
Replace the power supply.
Replace the system board.
Replace the processor. 

Red Power LED 
flashes ten times, 
once every 
second, followed 
by a two second 
pause.

10 Bad option card. Check each option card by removing the 
card (one at a time if multiple cards), then 
power on the system to see if fault goes 
away.
Once a bad card is identified, remove 
and replace the bad option card.
Replace the system board.

System does not 
power on and 
LEDs are not 
flashing.

None System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED turns 
green, then:
Check that the voltage selector, located on 
the rear of the power supply, is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.
Remove the expansion cards one at a time 
until the LED light on the system board 
turns on.
Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED does 
not turn on green then:
Check that the unit is plugged into a 
working AC outlet.
Open hood and check that the power 
button harness is properly connected to 
the system board.
Check that both power supply cables are 
properly connected to the system board.
Check to see if the LED light on the system 
board is turned on. If it is turned on, then 
replace the power button harness.
If the LED light on the system board is not 
turned on, then replace the power supply.
Replace the system board.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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D
Troubleshooting Without Diagnostics

Preliminary Checklist
This section describes some simple, preliminary tests and guidelines for troubleshooting the 
computer without using the diagnostics.

■ Are the computer and monitor connected to a working electrical outlet?

■ Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?

■ Is the computer turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed 
(embedded video on some models only) and a single monitor, the monitor must be plugged 
into the monitor connector on the source selected as the primary VGA adapter. During boot, 
the other monitor connectors are disabled and if the monitor is connected into these ports, the 
monitor will not function. You can select which source will be the default VGA source in 
Computer (F10) Setup.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the computer after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all bootable media (diskette, CD, or USB device) from the system before turning on 
the system.

■ Are all switches set correctly?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?
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Troubleshooting Without Diagnostics
Solving Minor Problems

Solving Minor Problems 
Problem Cause Possible Solution

Computer appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

1. Press and hold the power button 
for at least four seconds until the 
computer turns off.

2. Disconnect electrical plug from 
outlet.

Computer will not 
respond to USB 
keyboard or mouse.

Computer is in 
standby mode.

Press the power button to resume from 
standby mode.

System has locked up. Restart computer.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the power 
button for more than four seconds. Otherwise, the computer will shut down and you will lose 
any unsaved data. 

Computer date and 
time display is incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

1. Reset the date and time under 
Control Panel. 

2. Replace the RTC battery.

Computer appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is established.

Establish a network connection, or 
use Computer Setup or Microsoft 
Windows Device Manager to disable 
the network controller.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The Num 
Lock key can be disabled (or 
enabled) in Computer Setup.

Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

1. Unlock the Smart Cover Lock 
using Computer Setup.

2. Use the Smart Cover FailSafe Key 
in case of forgotten password, 
power loss, or computer 
malfunction.

Poor performance is 
experienced.

Processor is hot. 1. Ensure airflow to the computer is 
not blocked.

2. Ensure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Ensure the processor heatsink is 
installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.
D–2 390812-001 Service Reference Guide, dx7200



Troubleshooting Without Diagnostics
Poor performance is 
experienced. 
(continued)

Program previously 
accessed did not release 
reserved memory back to 
the system

Restart the computer.

Virus resident of the hard 
drive.

Run virus protection program.

Too many applications 
running.

1. Close unnecessary applications.
2. Add more memory.

Some software 
applications, especially 
games, are stressful on the 
graphics subsystem.

1. Lower the display resolution for 
the current application or consult 
the documentation that came with 
the application for suggestions on 
how to improve performance by 
adjusting parameters in the 
application.

2. Add more memory.
3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off 
automatically and the 
Power LED flashes Red 
two times, once every 
second, followed by a 
two second pause, and 
the computer beeps two 
times. Beeps continue 
for five iterations after 
which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked or 
not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure computer air vents are not 
blocked and the cooling fan is 
running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If not spinning, make sure 
the fan's cable is plugged onto 
the system board header. Ensure 
the fan is fully/properly seated or 
installed.

3. Replace the processor 
heatsink-fan assembly.

4. Reseat processor heatsink-fan 
assembly and verify that the fan 
is properly connected to the 
system board.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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System does not power 
on and the LEDs on the 
front of the computer 
are not flashing.

System unable to power 
on.

Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED turns green, then:
1. Check that the voltage selector 

(some models) is set to the 
appropriate voltage. 

2. Remove the expansion cards one 
at a time until the 5 V_aux light 
on the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED does not turn on green then:
1. Check that the unit is plugged 

into a working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. If the 5 V_aux light on the system 
board is on, then replace the 
power button harness.

5. If the 5 V_aux light on the system 
board is off, then replace the 
power supply.

6. Replace the system board.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems

Solving Power Supply Problems 
Problem Cause Solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of computer 
chassis (some models) is 
not switched to correct 
line voltage.

Select the proper AC voltage.

Power supply fault. Replace the power supply.

Computer powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps two times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink/fan 
assembly is not properly 
attached to the 
processor.

1. Ensure that the computer air 
vents are not blocked and the 
cooling fan is running.

2. Open hood, press the power 
button, and see if the processor 
fan spins. If the processor fan is 
not spinning, make sure the 
fan's cable is plugged onto the 
system board header. Ensure 
the fan is fully/properly seated 
or installed.

3. If the fan is pugged in and 
seated but not spinning, replace 
the processor fan.

4. Reseat processor heatsink and 
verify that the fan assembly is 
properly attached.

Power LED flashes Red, four 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps four times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector 
(some models), is set to the 
appropriate voltage. 

2. Open the hood and ensure the 
4- or 6-wire power supply cable 
is seated into the connector on 
the system board.

3. Check if a device is causing the 
problem by removing ALL 
attached devices. Power on the 
system. If the system enters the 
POST, then power off and 
replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the 
device causing the failure. 
Continue adding devices one at 
a time to ensure all devices are 
functioning properly.

4. Replace the power supply.
5. Replace the system board.
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Solving Diskette Problems

Solving Diskette Problems 
Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive button is not 
pushed in.

Push in drive button.

Files on diskette are 
damaged.

Check the program diskettes.

Drive cable is not 
properly connected.

Reconnect power cable. Ensure that 
all four pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cables.

Removable drive is not 
seated properly.

Reseat the drive.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is 
left on the diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.

Diskette is damaged. Replace the damaged diskette.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.
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A problem has occurred 
with a disk transaction.

The directory structure is 
bad, or there is a 
problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not 
formatted.

Format the diskette.

You are using the wrong 
diskette type for the 
drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart the computer by pressing the 
power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

Run Computer Setup and enable 
diskette boot in Storage > Boot 
Order.
Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options > 
Removable Media Boot.

✎ Both steps should be used as 
the Removable Media 
Boot function overrides the 
Boot Order enable 
command.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options> 
Removable Media Boot.

Network server mode is 
enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in 
Security > Password Options.

Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Solving Hard Drive Problems 
Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

Use a utility to locate and block 
usage of bad sectors. If necessary, 
reformat the hard disk.
In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

1. Check to see if the device is 
listed within Computer Setup. If 
it is listed, the probable cause is 
a driver problem. If it is not 
listed, the probable cause is a 
hardware problem.

2. If this is a newly installed drive, 
enter Setup and try adding a 
POST delay under Advanced 
> Power-On.

Drive’s controller is 
disabled in Computer 
Setup.

Run Computer Setup and enable the 
SATA controllers in Storage > 
Storage Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR 
missing message

System is trying to start 
from a non bootable 
diskette or USB device.

Remove the media from the drive.

System is trying to start 
from a damaged hard 
drive.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check hard drive format using 
fdisk:  
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
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Nonsystem disk/NTLDR 
missing message. 
(continued)

System files missing or 
not properly installed.

1. Insert a bootable system diskette 
and restart.

2. Check hard drive format using 
fdisk:  
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 

3. Install system files for the 
appropriate operating system if 
necessary.

Hard drive boot 
disabled in Computer 
Setup.

Run Computer Setup and enable the 
hard drive entry in the Storage > 
Boot Order list.

Bootable hard drive is 
not attached as first in a 
multi-hard drive 
configuration.

If attempting to boot from a hard 
drive, ensure it is attached to P60 
SATA 0.

Bootable hard drive's 
controller is not listed 
first in the Boot Order.

Enter Computer Setup and select 
Storage > Boot Order and 
ensure the bootable hard drive's 
controller is listed immediately under 
the Hard Drive entry.

Computer will not start. Hard drive is damaged. Observe the beeps and LED lights 
on the front of the computer. See 
Appendix C “POST Error 
Messages”.

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

1. Attempt the normal Windows 
“Shut Down” procedure. 

2. Press the power button for 
four or more seconds to turn off 
the power. 

3. Restart the computer using the 
power button.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Solving MultiBay Problems

Solving Display Problems

Solving MultiBay Problems
Problem Cause Solution

Drive not found. You attempted to hot 
plug a removable 
hard drive that has 
DriveLock security 
enabled. (This feature 
supported on some 
models.)

Shut down Windows and turn off 
the computer. Insert the drive into 
the MultiBay, if it is not already 
inserted. Turn on the computer.

MultiBay is hidden in 
Computer Setup.

Enter Computer Setup and set 
MultiBay to Device Available in 
Security > Device Security.

Solving Display Problems 
Problem Cause Solution

Blank screen (no video). Monitor is not turned 
on.

Turn on the monitor and check that 
the monitor light is on.

The cable connections 
are not correct.

Check the cable connections from 
the monitor to the computer and to 
the electrical outlet.

Bad monitor. Try a different monitor.

Screen blanking utility 
installed or energy 
saver features enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

System ROM is 
corrupted; system is 
running in Boot Block 
Emergency Recovery 
Mode (indicated by 
eight red blinks from the 
power LED and eight 
simultaneous beeps).

1. Reflash the system ROM with the 
latest BIOS image. 

2. Replace the system board.

Fixed-sync monitor will 
not sync at the 
resolution chosen.

Ensure that the monitor can accept 
the same horizontal scan rate as the 
resolution chosen.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose any unsaved data.
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Blank screen (no video). 
(continued)

Monitor cable plugged 
into the wrong 
connector.

If the computer system has both 
an integrated graphics connector 
and a graphics expansion card 
connector, plug the monitor cable 
into the expansion card connector.

✎ If the graphics card is a 
standard PCI expansion card, 
you can enable the integrated 
graphics in Computer Setup. If 
a PCI-Express graphics card is 
installed, the integrated 
graphics can not be enabled.

Monitor settings in the 
computer are not 
compatible with the 
monitor.

1. Restart the computer and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode 
and press Enter.

3. In Windows Control Panel, 
double-click the Display icon 
and select the Settings tab.

4. Use the sliding control to reset 
the resolution.

Blank screen and the 
power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video memory error. 1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Blank screen and the 
power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. 
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Solving Display Problems (Continued)

Problem Cause Solution
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Blank screen and the 
power LED flashes Red 
seven times, once every 
second, followed by a two 
second pause, and the 
computer beeps seven 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

System board failure 
(ROM detected failure 
prior to video.)

Replace the system board.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller 
was upgraded, the 
correct video drivers 
may not be loaded.

Install the video drivers included in 
the upgrade kit.

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor connections 
may be incomplete or 
the monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Solving Display Problems (Continued)

Problem Cause Solution
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Image is not centered. Position may need 
adjustment.

Press the Menu button to access the 
OSD menu. Select 
ImageControl/Horizontal 
Position or VerticalPosition to 
adjust the horizontal or vertical 
position of the image.

“No Connection, Check 
Signal Cable” displays on 
screen.

Monitor video cable is 
disconnected.

Connect the video cable between 
the monitor and computer.

Ä Ensure the computer power is 
off while connecting the video 
cable.

“Out of Range” displays on 
screen.

Video resolution and 
refresh rate are set 
higher than what the 
monitor supports.

Restart the computer and enter Safe 
Mode. Change the settings to a 
supported setting then restart the 
computer so that the new settings 
take effect.

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing coil 
has been activated.

None. It is normal for the 
degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some monitors 
to make a clicking noise when 
turned on and off, when going in 
and out of standby mode, and when 
changing resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are too 
high.

Lower brightness and/or contrast 
settings.

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen. 
(flat panel monitors using 
an analog VGA input 
connection only)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display 
menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen 
display functions. Download 
SoftPaq SP20930 or SP22333, 
depending on the monitor, to 
assist with the synchronization.

Graphics card is not 
seated properly or is 
bad.

1. Reseat the graphics card.
2. Replace the graphics card.

Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy 
the symbol from the Character Map 
into a document.

Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems

Solving Audio Problems 

Problem Cause Solution

Errors when installing 
audio drivers.

The HP audio codec 
requirs that Microsoft 
Universal Architecture 
(UAA) drivers, which 
provide support for the 
HD audio bus, to be 
installed before the 
audio codec driver can 
be installed. (UAA 
drivers are different for 
each operating system 
(OS) and OS service 
pack.)

Install the Microdoft UAA driver 
before installing the Realtek driver.

Sound cuts in and out. Processor resources are 
being used by other 
applications.

Shut down all open 
processor-intensive applications.

Direct sound latency, 
common in many media 
player applications.

In Windows XP:
1. From the Control Panel, 

select Sounds and Audio 
Devices.

2. On the Audio tab, select a 
device from the Sound 
Playback list.

3. Click the Advanced, button 
and select the Performance 
tab.

4. Set the Hardware 
acceleration slider to None 
and the Sample rate 
conversion quality slider to 
Good and retest the audio.

5. Set the Hardware 
acceleration slider to Full 
and the Sample rate 
conversion quality slider to 
Best and retest the audio.

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on 
the taskbar and use the volume 
slider to adjust the volume.

The external speakers 
are not turned on.

Turn on the external speakers.

Audio is hidden in 
Computer Setup.

Enable the audio in Computer 
Setup: Security > Device 
Security >Audio.
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Sound does not come 
out of the speaker or 
headphones. (continued)

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Digital CD audio is not 
enabled.

Enable digital CD audio:
1. From the Control Panel, select 

System.
2. On the Hardware tab, click 

the Device Manager button.
3. Right-click on the CD/DVD 

device and select Properties.
4. On the Properties tab, make 

sure “Enable digital CD 
audio for this CD-ROM 
device” is checked.

Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, 
Speech and Audio 
Devices, then click Sounds 
and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
any unsaved data will be lost.

Sound from headphones is 
not clear or muffled.

Headphones are 
plugged into the rear 
audio output connector. 
The rear audio 
connector is for 
powered audio devices 
and is not designed for 
headphone use.

Plug the headphones into the 
headphone connector on the front of 
the computer.

Computer appears to be 
locked up while recording 
audio.

The hard disk may be 
full.

1. Before recording, make sure 
there is enough free space on 
the hard disk. 

2. Try recording the audio file in a 
compressed format.

Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Printer Problems

Solving Keyboard and Mouse Problems

Solving Printer Problems 
Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
driver for the 
application are not 
installed.

1. Install the correct printer driver 
for the application.

2. Try printing using the 
MS-DOS command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being 
used. If the printer works, reload 
the printer driver.

If you are on a network, 
you may not have made 
the connection to the 
printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables.

Printer prints garbled 
information.

The correct printer 
driver is not installed.

Install the correct printer driver for 
the application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

1. Check the paper tray and refill it 
if it is empty. 

2. Select online.

Solving Keyboard and Mouse Problems 
Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. Turn off the computer. 
2. Reconnect the keyboard to the 

back of the computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using 
the mouse and then restart the 
computer.
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Keyboard commands and 
typing are not recognized 
by the computer. 
(continued)

Keyboard needs 
repairs.

Replace the keyboard.

Wireless device error. 1. Check software, if available, for 
device battery status.

2. Replace device batteries.
3. Reset receiver and keyboard.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and any unsaved data will be lost.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled  
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

1. Shut down the computer using 
the keyboard.

2. Plug the mouse connector into 
the back of the computer (or the 
keyboard) and restart the 
computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using the 
keyboard and then restart the 
computer.

Mouse may need 
cleaning.

Remove the roller ball cover on the 
mouse and clean it.

Mouse needs repairs. Replace the mouse.

Wireless device error. 1. Check software, if available, for 
device battery status.

2. Replace device batteries.
3. Reset receiver and mouse.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose any unsaved data.

Mouse will only move 
vertically or horizontally, or 
movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it.

Solving Keyboard and Mouse Problems (Continued)

Problem Cause Solution
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an 
additional diskette drive. If you install a plug and play device, Windows XP automatically 
recognize the device and configure the computer. If you install a non–plug and play device, you 
must reconfigure the computer after completing installation of the new hardware. In Windows 
XP, use the Add Hardware Wizard and follow the instructions that appear on the screen.

Solving Hardware Installation Problems 
Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of changes 
to the configuration, you 
did not accept them.

Reboot the computer and follow the 
instructions for accepting the 
changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows XP Device Manager 
to deselect the automatic settings for 
the board and choose a basic 
configuration that does not cause a 
resource conflict. You can also use 
Computer Setup to reconfigure or 
disable devices to resolve the 
resource conflict.

Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to 
determine if you are using the 
correct memory modules and to 
verify the proper installation.

2. Observe the beeps and LED 
lights on the front of the 
computer. See Appendix C 
“POST Error Messages” to 
determine possible causes.
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Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Video card is not seated 
properly or is bad, or 
system board is bad.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Power LED flashes Red ten 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps ten times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved

Bad option card. 1. Check each option card by 
removing the cards one at time 
(if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once bad card is identified, 
remove and replace bad option 
card.

3. Replace the system board.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems 
Problem Cause Solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Use the Network Connections 
application in Control Panel to 
enable Wake-on-LAN. 

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via the 
Device Manager.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light 
does not turn on or it 
never flashes.

✎ The network status 
light should flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Use the Network control 
application to verify that the device 
is working properly. 

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via Device 
Manager.

Network driver is not 
properly loaded.

Reinstall network drivers. 

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the correct 
operating mode. 

Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that both ends of the data 
cable are securely connected. 

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
is defective.

Replace the system board (NIC is 
integral to the system board).
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Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are not 
loaded, or driver 
parameters do not match 
current configuration.

Make sure the network drivers are 
loaded and that the driver 
parameters match the configuration 
of the network controller.
Make sure the correct network client 
and protocol is installed.

The network controller is 
not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Network controller stops 
working without apparent 
cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using 
the Restore Plus! CD.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The network controller is 
defective.

Replace the system board.

New network card will 
not boot.

New network card may be 
defective or may not meet 
industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence 
to boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that 
the Remote System Installation 
Server contains the NIC drivers for 
your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems

Ä
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC 
memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems 
Problem Cause Solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

Memory module is not 
the correct type or 
speed or the new 
memory module is not 
seated properly.

Replace module with the correct 
industry-standard device for the 
computer.

On some models, ECC and non-ECC 
memory modules cannot be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during POST 
is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Integrated graphics 
may use system 
memory.

No action required.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more 
memory to the computer.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.
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Solving Processor Problems
.

Solving CD-ROM and DVD Problems

Solving Processor Problems
Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Power LED flashes Red 
three times, once every 
second, followed by a two 
second pause, and the 
computer beeps three 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

Processor is not seated 
properly or not 
installed.

1. Check to see that the processor 
is present.

2. Reseat the processor.

Solving CD-ROM and DVD Problems 
Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

Removable Media Boot 
is not enabled through 
the Computer Setup 
utility.

Run the Computer Setup utility and 
enable booting to removable media 
and verify boot order settings.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

Network Server Mode 
is enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in Security 
> Password Options. 

Boot order not correct. Run Computer Setup and change 
boot sequence in Storage > Boot 
Order.

CD-ROM or DVD devices 
are not detected or driver is 
not loaded.

Drive is not connected 
properly or not properly 
configured.

1. Reconnect power and data 
cables to the drive.

2. Install correct device driver.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.
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Movie will not play in the 
DVD drive. (continued)

Decoder software is not 
installed.

Install decoder software.

Damaged media. Replace media.

Movie rating locked out 
by parental lock.

Use DVD software to remove 
parental lock.

Media installed upside 
down.

Reinstall media.

Cannot eject compact disc 
(tray-load unit).

Disc not properly seated 
in the drive.

1. Turn off the computer and insert 
a thin metal rod into the 
emergency eject hole and push 
firmly. 

2. Slowly pull the tray out from the 
drive until the tray is fully 
extended, then remove the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

Media has been 
inserted upside down.

Re-insert the Media with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove 
or uninstall the device in 
question.

2. Restart the computer and let 
Windows detect the device.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower recording 
speed.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution
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Solving Drive Key Problems

Solving Front Panel Component Problems

Solving Drive Key Problems
Problem Cause Solution

Drive Key is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for 
the Drive Key in Windows XP.

The computer boots to DOS 
after making a bootable 
Drive Key.

Drive Key is bootable. Install the Drive Key after the 
operating system boots.

Solving Front Panel Component Problems
Problem Cause Solution

A USB device, headphone, 
or microphone is not 
recognized by the 
computer.

It is not properly 
connected.

1. Turn off the computer.
2. Reconnect the device to the front of 

the computer and restart the 
computer.

The device does not 
have power.

If the USB device requires AC power, 
be sure one end is connected to the 
device and one end is connected to a 
live outlet.

The correct device 
driver is not installed.

1. Install the correct driver for the 
device.

2. You might need to reboot the 
computer.

The cable from the 
device to the computer 
does not work.

1. If possible, replace the cable.
2. Restart the computer.

The device is not 
working.

1. Replace the device.
2. Restart the computer.
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Solving Internet Access Problems

Solving Internet Access Problems 
Problem Cause Solution

Unable to connect to the 
Internet.

Internet Service Provider 
(ISP) account is not set 
up properly.

Verify Internet settings or contact the 
ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the 
quick setup documentation.

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/ DSL modem is 
not plugged in.

Plug in cable/DSL modem. You 
should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 UTP cable is 
disconnected.

Connect the CAT5 UTP cable 
between the cable modem and the 
computers’s RJ-45 connector. (If the 
connection is good, the “PC” LED 
light on the front of the cable/DSL 
modem will be on.)

IP address is not 
configured properly.

Contact the ISP for the correct IP 
address.

Cookies are corrupted. Windows XP
1. Select Start > Control 

Panel.
2. Double-click Internet 

Options.
3. On the General tab, click the 

Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to the 
ISP before some 
programs will start.

Log on to the ISP and launch the 
desired program.
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Internet takes too long to 
download Web sites.

Modem is not set up 
properly.

Verify that the correct modem speed 
and COM port are selected.
For Windows XP
1. Select Start > Control 

Panel.
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port your 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Solving Internet Access Problems (Continued)

Problem Cause Solution
Service Reference Guide, dx7200 390812-001 D–27



Troubleshooting Without Diagnostics
D–28 390812-001 Service Reference Guide, dx7200



E
System Board and Riser Board Reference 

Designators

These reference designators are used on most but not all HP system and riser boards.

Designator Component 
BAT 
CR1 
CR2 
CR3 
CR4

Battery socket/Battery 
LED - 5V_Aux (on) 
Health-LED 
UID LED 
Power LED

CR35 
E14 
E15 
E25 
E49/JP49

Hard drive activity LED 
Boot block header/jumper 
Boot block recovery header 
CPLD programming header 
Clear Password header/jumper

E50 
J7 
J9 
J10 
J11

Clear CMOS header 
RJ45 jack 
Stacked RJ45/Dual USB 
Quad stacked USB 
First IEEE 1394 connector

J12  
J13 
J14 
J20 - 29 
J30

Second IEEE 1394 connector 
SPDIF input 
SPDIF output 
PCI slots 
PCI extender slot (male)

J31 - J35 
J37 
J38 
J39 
J40

PCI Express slots 
Primary SCSI connector 
Secondary SCSI connector 
Stacked parallel/SCSI connector 
AGP slot

J41 
J50 
J51 
J52 
J53

x16 PCI Express slot for graphics 
First parallel port 
Second parallel port 
Double-stacked parallel port, Top = Port B, Bottom = Port A 
Parallel port over single Serial Port

J54 
J55 
J65 
J66 
J67

Parallel port over Serial Port and Video Port 
Parallel port over dual VGA ports 
DVI connector 
Keyboard connector, PS/2 (Closest to power supply) 
Mouse connector, PS/2
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System Board and Riser Board Reference Designators
J68 
J69 
J70 
J71 
J72

Stacked mouse (Top)/keyboard (Bottom) connector 
Video connector, VGA 
Primary single USB connector 
Secondary single USB port 
Microphone jack

J73 
J74 
J75 
J76 
J77

Line-in jack 
Line-out jack 
Headphone jack 
Volume control 
Double-stacked headphone (Bottom)/microphone (Top) connector

J78 
J80 
J81 
J82 
J83

Double-stacked line-in (Top)/line-out (Bottom) connector 
Stacked serial/audio connector 
Primary double-stack USB, Top = Port 2, Bottom = Port 1 
Secondary double-stack USB, Top = Port 4, Bottom = Port 3 
Triple-stacked audio jack (line in, line out/headphone, microphone)

J101 
J9020-J9029 
J9030-J9034 
JP49/E49 
L1

Security board connector, daughter card 
PCI slots on riser card 
PCI express slots on riser card 
Clear password header/jumper 
USB front port choke (1st)

L2 
L3 
L4 
L5 
P1

USB rear port choke (1st) 
USB rear port choke (2nd) 
USB rear port choke (3rd) 
USB front port choke (2nd) 
P/S connector (20 or 24 pin)

P2 
P3 
P4 
P5 
P6

Second P/S connector (as required) 
VCCP 12V header  
Secondary Processor 12V header 
Main Power/HDD LED connector  
Speaker connector

P7 
P8 
P9 
P10 
P11

Audio connector (from CD-ROM) 
Primary chassis fan connector 
Secondary chassis fan connector 
Diskette drive connector 
Auxiliary Audio connector

P12 
P13 
P15 
P16 
P17

Alert on LAN NIC connector 
VRM module footprint 
AUI connector 
Fan command/fan sink header (may be 2 or 4 pin) 
Digital audio expansion header

P18 
P19 
P20 
P21 
P22

SPDIF internal input header 
SPDIF internal output header 
Primary IDE connector 
Secondary IDE/MultiBay connector 
Header for NEWCARD

Designator Component (Continued)
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System Board and Riser Board Reference Designators
P23 
P24 
P25  
P26 
P27

Header for front panel audio  
Header for front panel USB 
Internal USB connector 1 
Internal USB connector 2 
MultiBay header

P29 
P30 
P40 
P41 
P52

SCSI LED connector 
PCI extender slot (female) 
Blade PC graphics connector (outboard) 
Blade PC graphics connector (inboard) 
Second serial port 

P54 
P55 
P58 
P60 
P61

Primary serial port 
Double stack serial port, Top = Serial B, Bottom = Serial A 
Riser edge connector (male-mates with J30) 
Primary Serial ATA (SATA) connector 
Second Serial ATA (SATA) connector

P62 
P63 
P64 
P65 
P66

Third Serial ATA (SATA) connector 
Fourth Serial ATA (SATA) connector 
VSFF expansion connector 
Graphics option connector 
Fifth Serial ATA (SATA) connector

P67 
P68 
P69 
P70 
P71

Sixth Serial ATA (SATA) connector 
Seventh Serial ATA (SATA) connector 
Eighth Serial ATA (SATA) connector 
Primary (CPU) fan header for fansink 
Secondary CPU fan header for fansink

P80 
P81 
P82 
P83 
P84

Primary Serial Attached SCSI (SAS) connector 
Second Serial Attached SCSI (SAS) connector 
Third Serial Attached SCSI (SAS) connector 
Fourth Serial Attached SCSI (SAS) connector 
Fifth Serial Attached (SAS) connector

P85 
P86 
P87 
P101 
P106

Sixth Serial Attached (SAS) connector 
Seventh Serial Attached (SAS) connector 
Eighth Serial Attached (SAS) connector 
Security board connector, system board 
Secondary speaker header

P124 
P125 
P126 
P216 
SW2

Hood lock header 
Hood sensor header 
Flying parallel port header 
White box chassis fan header 
Security hood switch on riser card

SW50 
U2 
U3 
U4 
U5

Clear CMOS switch/push button 
Single chip solution (combined north bridge/south bridge) 
North bridge 
South bridge 
Super I/O

Designator Component (Continued)
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System Board and Riser Board Reference Designators
U6 
U7 
U10 
U11 
U12

Clock chip 
64 bit Bridge 
LOM1 
LOM1 EEPROM 
LOM1 PHY

U13 
U14 
U16 
U17 
U18

Audio Codec 
Audio amplifier 
LOM2 
LOM2 EEPROM 
LOM2 PHY

U19 
U20 
U29 
U30 
U31

SPI ROM 
Fan controller 
TMDS controller 
Parallel port diode array 
First serial port transceiver 

U32 
U46 
U50 
U51 
U52

Second serial port transceiver 
VRM controller 
USB front port power switch 
First USB rear port power switch 
Second USB rear port power switch

U53 
XBT 
XMM1 
XMM2 - XMM5 
XU1

Third USB rear port power switch 
Battery retainer 
Memory slot. DIMM1 or RIMM1 populated and tested 
Following memory slots 
Primary processor socket 

XU2 
XU15/U15 
XU19/U19 
Y1 
Y2

Secondary processor socket 
System ROM and Socket (Socket = XU15, ROM = U15) 
SPI ROM and socket (XU19 = socket, U19 = SPI ROM) 
Primary (TH) system clock crystal 
Secondary (SMT) system clock crystal

Y3 
Y4 
Y5/H5

Primary NIC clock crystal 
Secondary NIC clock crystal 
RTC clock crystal/tie-down

Designator Component (Continued)
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F
Memory

The dc7600 series computers with Intel-based processors come with double data rate 2 
synchronous dynamic random access memory (DDR2-SDRAM) dual inline memory modules 
(DIMMs). 

ÄCAUTION: DDR and DDR2 memory modules are not interchangeable.

DDR2-SDRAM DIMMs 
The memory sockets on the system board can be populated with up to four industry-standard 
DIMMs. These memory module sockets are populated with at least one preinstalled memory 
module. To achieve the maximum memory support, you can populate the system board with up 
to 4GB of memory configured in a high-performing dual channel mode.

For proper system operation, the DDR2-SDRAM DIMMs must be:

■ industry-standard 240-pin

■ unbuffered PC2 4200 533 MHz-compliant or PC2 5300 667 MHz-compliant

■ 1.8volt DDR2-SDRAM DIMMs

The DDR2-SDRAM DIMMs must also:

■ support CAS latency 4 (CL = 4) for PC2 4200 533 MHz or CAS latency 5 (CL = 5) for PC2 
5300 667 MHz

■ contain the mandatory JEDEC SPD information

In addition, the computer supports:

■ 256Mbit, 512Mbit, AND 1 Gbit non-ECC memory technologies (all three Mbit technologies 
may be used with each other with no performance degradation)

■ single-sided and double-sided DIMMS 

■ DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM 
are not supported 

DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are 
labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM2 operate in memory 
channel A. Sockets XMM3 and XMM4 operate in memory channel B.
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Memory
The system board shown may differ from the one in your product.

 

The system will automatically operate in single channel mode, dual channel Asymmetric mode, 
or a a higher-performing dual channel Interleaved mode, depending on how the DIMMs are 
installed. 

To identify the operating mode, run Computer Setup and select the System Information menu 
item. The operating memory mode will appear in the line showing the system total memory.

■ The system will operate in single channel mode if the DIMM sockets are populated in one 
channel only.

■ The system will operate in dual channel Asymmetric mode if the total memory capacity of 
the DIMMs in Channel A is not equal to the total memory capacity of the DIMMs in 
Channel B.

■ The system will operate in a higher-performing dual channel Interleaved mode if the total 
memory capacity of the DIMMs in Channel A is equal to the total memory capacity of the 
DIMMs in Channel B. However, the technology and device width can vary between the 
channels, For example, if Channel A is populated with two 256 MB DIMMS and Channel B 
is populated with one 512 MB DIMM, the system will operate in Interleaved mode.

■ In any mode, the maximum operational speed is determined by the slowest DIMM in the 
system.

Item Description Socket Color

1 DIMM socket XMM1, Channel A Black

2 DIMM socket XMM2, Channel A White

3 DIMM socket XMM3, Channel B Black

4 DIMM socket XMM4, Channel B White
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4-pin power pin assignments A–7
24-pin MicroFit power pin assignments A–7
24-pin power pin assignments A–7, A–11
6-pin power pin assignments A–8

A
access panel

MT removal and replacement 6–4
ST removal and replacement 7–8

Altiris 3–2
Deployment Solution Agent 3–2
HP Client Management Solutions 3–4

asset tracking 3–14
ATA/ATAPI (IDE) drive cable pin assignments 

A–6

B
backing up files 1–2
battery

disposal 5–9
MT removal and replacement 6–33
ST removal and replacement 7–40

bezel insert
MT removal and replacement 6–8
ST removal and replacement 7–9

blank screen D–10, D–11
Boot Block Emergency Recovery Mode 3–7

C
cable

MT removal and replacement 6–17
proper handling 5–8

cable lock
MT 6–2
ST 7–6

cable management
MT 6–9
ST 7–11

cable pinouts
PATA data 4–3
PATA power 4–4
SATA data 4–2
SATA power 4–2

cautions
AC power 5–1
adding devices 1–1
cables 5–8
cooling fan 5–7
cover lock security 3–22
electrostatic discharge 5–3
FailSafe Key 3–23
keyboard cleaning 5–6
keyboard keys 5–6
operating system installation 1–1
protecting ROM 3–7

change notification 3–6
changing password 3–19
chassis

MT illustrated 5–1
ST illustrated 5–2

chassis fan
MT removal and replacement 6–22
ST removal and replacement 7–28

cleaning
computer 5–6
keyboard 5–6
monitor 5–7
mouse 5–7

clearing password 3–20
computer cleaning 5–6
computer cover

MT removal and replacement 6–4
ST removal and replacement 7–8

computer pauses D–2
Computer Setup

accessing 2–3
Advanced menu 2–11
File menu 2–4
overview 2–2
Security menu 2–8
Storage menu 2–5

configuring power button 3–13
connector pin assignments A–1 to A–7
country-specific power cord set requirements B–2
cover lock, smart 3–22
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Index
D
Dantz Retrospect Express 3–5
date and time display problems D–2
DDR2 memory F–1
deleting password 3–19
delimiter characters, table 3–20
device drivers, installing/upgrading 1–1
diagnostic tool for hard drives 3–24
diagnostics utility 2–14
DIMMs F–1
disassembly preparation

MT 6–1
ST 7–1

diskette drive
MT removal and replacement 6–17
ST removal and replacement 7–21

diskette drive bezel
MT removal and replacement 6–8
ST removal and replacement 7–9

drive
capacities 4–5
MT removal and replacement 6–17
partition size 4–5
protecting 3–24
ST external removal and replacement 7–21
ST hard drive removal and replacement 7–23
ST optical drive removal and replacement 7–19

drive bezel
MT 3.5" 6–8
MT 5.25" 6–7
ST assorted 7–10

drive positions
MT 6–16
ST 7–18

Drivelock 3–20
dual-state power button 3–13

E
electrostatic discharge. See ESD
entering

power-on password 3–18
setup password 3–18

error messages, POST C–1 to C–7
ESD (electrostatic discharge)

materials and equipment 5–4
preventing damage 5–3

Ethernet
AUI pin assignments A–2
BNC pin assignments A–1
RJ-45 pin assignments A–2

expansion card
MT PCI Express socket removal and 

replacement 6–14
MT standard socket removal and replacement 

6–13
ST PCI Express socket removal and 

replacement 7–17
ST standard socket removal and replacement 

7–15
expansion card retainer

MT removal and replacement 6–12
ST removal and replacement 7–14

expansion slot cover
MT removal and replacement 6–13
ST removal and replacement 7–15

external 3.5-inch drive
ST removal and replacement 7–21

external security
MT 6–2
ST 7–6

F
FailSafe key, ST 7–3
fan shroud, ST removal and replacement 7–27
fan, chassis

MT removal and replacement 6–22
ST removal and replacement 7–28

fan, power supply 5–7
FAT or FAT32 to NTFS conversion 1–2
fault notification 3–24
flashing LEDs C–9
front bezel

MT removal and replacement 6–5
ST removal and replacement 7–9

front I/O devices
MT removal and replacement 6–24
ST removal and replacement 7–29

front I/O panel
MT removal and replacement 6–23

G
grounding methods 5–4

H
hard drive

diagnostic tool 3–24
MT removal and replacement 6–17
proper handling 5–8
ST removal and replacement 7–23

headphone pin assignments A–4
heatsink
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Index
MT removal and replacement 6–26
ST removal and replacement 7–31

hood sensor
ST removal and replacement 7–5

HP Client Management Solutions 3–4
HP Client Manager 3–3
HP Insight Diagnostics 2–14
HP Local Recovery 3–5
HP software. See software
HP System Software Manager 3–3

I
image deployment methods 3–1
infrared (IR) transceiver, external, pin assignments 

A–5
initial configuration 3–1
Insight Diagnostics 2–14

K
keyboard

cleaning 5–6
delimiter characters, national 3–20
pin assignments A–1

L
LEDs

blinking power C–9
blinking PS/2 keyboard C–9

line-in audio pin assignments A–4
line-out audio pin assignments A–4
Local Recovery 3–2
locking Smart Cover Lock 3–23

M
memory

DDR2 specifications F–1
MT removal and replacement 6–10
socket assignments F–2
ST removal and replacement 7–12

microphone pin assignments A–3
Minitower See MT
monitor

blank screen D–10, D–11
blurry video D–12
cleaning 5–7
dim characters D–12
pin assignments A–5

mouse
cleaning 5–7
pin assignments A–1

MT

3.5" drive bezel removal and replacement 6–8
5.25" drive bezel removal and replacement 6–7
access panel removal and replacement 6–4
battery removal and replacement 6–33
cable lock 6–2
chassis fan removal and replacement 6–22
chassis, illustrated 5–1
disassembly preparation 6–1
diskette drive bezel removal and replacement 

6–8
diskette drive cable connecting 6–20
diskette drive cable disconnecting 6–17
drive positions 6–16
drive removal and replacement 6–17
expansion slot cover 6–13
external security 6–2
front bezel removal and replacement 6–5
front I/O devices removal and replacement 6–24
front I/O panel removal and replacement 6–23
hard drive cable connecting 6–21
hard drive cable disconnecting 6–18
heatsink removal and replacement 6–26
memory removal and replacement 6–10
optical drive cable connecting 6–20
optical drive cable disconnecting 6–17
padlock 6–3
PCI expansion card removal and replacement 

6–13
PCI Express expansion card removal and 

replacement 6–14
power supply removal and replacement 6–30
power switch assembly removal and 

replacement 6–25
preparation for disassembly 6–1
processor removal and replacement 6–27
speaker removal and replacement 6–29
system board removal and replacement 6–32

MultiBay
CD-ROM adapter pin assignments A–6
security 3–20

N
national keyboard delimiter characters 3–20
notification of hardware and software changes 3–6

O
optical drive

MT removal and replacement 6–17
ST removal and replacement 7–19

overheating, prevention 5–5
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P
padlock

MT removal and replacement 6–3
ST removal and replacement 7–7

parallel interface pin assignments A–3
password

changing 3–19
clearing 3–20
deleting 3–19
options 2–8
power-on 2–8, 3–18
security 3–17
setup 2–8, 3–17, 3–18

PATA
data cable pinouts 4–3
power cable pinouts 4–4

PCI expansion card
MT removal and replacement 6–13
ST removal and replacement 7–15

PCI Express expansion card
MT removal and replacement 6–14
ST removal and replacement 7–17

PCI Express pin assignments A–9
PCN (Proactive Change Notification) 3–6
POST (Power-On Self-Test) 2–1
POST error messages C–1 to C–7
power button, configuring 3–13
power cord set requirements

country specific B–2
general B–1

power supply
fan 5–7
MT removal and replacement 6–30
ST removal and replacement 7–35

power switch assembly
MT removal and replacement 6–25
ST removal and replacement 7–30

power-on password
changing 3–19
deleting 3–19
entering 3–18

Power-On Self-Test (POST) 2–1
Preboot Execution Environment (PXE) 3–2
Proactive Change Notification (PCN) 3–6
problems, solving

audio D–14
CD-ROM and DVD D–23
diskette D–6
display D–10, D–11

drive key D–25
front panel components D–25
hard drive D–8
hardware installation D–18
Internet access D–26
keyboard D–16
memory D–22
mouse D–16
MultiBay D–10
network D–20
optical drives D–23
power supply D–5
printer D–16
processor D–23

processor
MT removal and replacement 6–27
ST removal and replacement 7–32

protecting ROM 3–7
PXE (Preboot Execution Environment) 3–2

R
recovery, software 3–1
Remote ROM Flash 3–7
remote setup 3–2
removal and replacement

MT 3.5" drive bezel 6–8
MT 5.25" drive bezel 6–7
MT access panel 6–4
MT battery 6–33
MT cable lock 6–2
MT chassis fan 6–22
MT diskette drive bezel 6–8
MT drive 6–17
MT front bezel 6–5
MT front I/O devices 6–24
MT front I/O panel 6–23
MT heatsink 6–26
MT memory 6–10
MT padlock 6–3
MT PCI expansion card 6–13
MT PCI Express expansion card 6–14
MT power supply 6–30
MT power switch assembly 6–25
MT processor 6–27
MT speaker 6–29
MT system board 6–32
ST battery 7–40
ST cable lock 7–6
ST chassis fan 7–28
ST computer cover 7–8
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ST expansion card retainer 7–14
ST external 3.5-inch drive 7–21
ST fan shroud 7–27
ST front drive bezel 7–9
ST front I/O devices 7–29
ST hard drive 7–23
ST heatsink 7–31
ST hood sensor 7–5
ST memory 7–12
ST optical drive 7–19
ST padlock 7–7
ST PCI expansion card 7–15
ST PCI Express expansion card 7–17
ST power supply 7–35
ST power switch assembly 7–30
ST processor 7–32
ST Smart Cover Lock 7–3
ST speaker 7–34
ST system board 7–37

retired solutions 3–6
riser board

reference designators E–1
ROM flash 3–7

S
safety precautions, cleaning 5–5
SATA

data cable pinouts 4–2
power cable pinouts 4–2

SATA pin assignments A–8
screws, correct size 5–8
SCSI pin assignments A–4
SDRAM (synchronous dynamic random access 

memory) F–1
security

DriveLock 3–20
embedded TPM chip 3–24
HP ProtectTools Security Manager 3–24
MT external 6–2
MultiBay 3–20
password 3–17
ST external 7–6

security features
mechanical 3–17
Setup (F10) 3–14

serial interface pin assignments A–3
service considerations 5–7
setup

software 1–2
Windows 1–1

setup password
changing 3–19
deleting 3–19
entering 3–18
setting 3–17

Slim Tower. See ST
Smart Cover Lock

locking 3–23
ST removal and replacement 7–3
unlocking 3–23

Smart Cover Sensor
protection levels 3–22
setting 3–22

software
Altiris Deployment Solution Agent 3–2
asset tracking 3–14
Boot Block Emergency Recovery Mode 3–7
Computer Setup Utilities 2–1
Dantz Retrospect Express 3–5
Drive Protection System 3–24
Fault Notification and Recovery 3–24
HP Client Management Solutions using Altiris 

3–4
HP Client Manger 3–3
HP Insight Diagnostics 2–14
HP Local Recovery 3–2
HP ProtectTools Security Manager 3–24
HP System Software Manager 3–3
image deployment 3–1
Proactive Change Notification 3–6
recovery 3–1
Remote ROM Flash 3–7
Remote System Installation 3–2
setup 1–2
Subscriber’s Choice 3–6

spare part number
tamper resistant wrench 5–7
Torx T-15 screwdriver 5–7

speaker
MT removal and replacement 6–29
ST removal and replacement 7–34

ST
battery removal and replacement 7–40
cable lock removal and replacement 7–6
cable management 7–11
chassis fan removal and replacement 7–28
chassis, illustrated 5–2
computer cover removal and replacement 7–8
disassembly preparation 7–1
drive bezel inserts 7–10
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drive positions 7–18
expansion card removal and replacement 7–15
external 3.5-inch drive removal and replacement 

7–21
external security 7–6
FailSafe key 7–3
fan shroud removal and replacement 7–27
front drive bezel removal and replacement 7–9
front I/O devices removal and replacement 7–29
hard drive removal and replacement 7–23
heatsink removal and replacement 7–31
hood sensor removal and replacement 7–5
memory removal and replacement 7–12
optical drive removal and replacement 7–19
padlock removal and replacement 7–7
PCI expansion card retainer removal and 

replacement 7–14
PCI Express expansion card removal and 

replacement 7–17
power supply removal and replacement 7–35
power switch assembly removal and 

replacement 7–30
preparation for disassembly 7–1
processor removal and replacement 7–32
Smart Cover Lock removal and replacement 7–3
speaker removal and replacement 7–34
system board removal and replacement 7–37
tamper-proof screws 7–3

static electricity 5–3
Subscriber’s Choice 3–6
system board

MT removal and replacement 6–32
reference designators E–1

ST removal and replacement 7–37

T
tamper-proof screws

ST 7–3
tool 5–7

temperature control 5–5
Torx T-15 screwdriver 5–7
TPM Embedded Security Chip 3–24
Troubleshooting D–1

U
Ultra SCSI pin assignments A–5
unlocking Smart Cover Lock 3–23
USB pin assignments A–3

V
ventilation, proper 5–5

W
Wake-on-LAN feature D–20
Web sites

HP 1–1
HPQFlash 3–7
PC Deployment 3–1
Proactive Change Notification 3–6
Remote ROM Flash 3–7
replicating setup, BIOS utility 3–10
ROM Flash 3–7
security 3–24
Subscriber’s Choice 3–6
support software 3–13
support software CD subscription 1–1

wrench, tamper-resistant 7–3
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